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What this exercise is about
The objective of this lab is to provide you with an understanding of WebSphere Adapter for FTP and
inbound event processing. In this lab you will deploy the WebSphere Adapter for FTP, using WebSphere

Integration Developer, and integrate it with an SCA application that polls for inbound events and processes
those inbound requests from the file system.

Lab requirements
List of system and software required for the student to complete the lab.
 WebSphere Integration Developer V7.0 installed and updated with latest fixes
e WebSphere Process Server V7.0 Test Environment installed and updated latest fixes

e Extract Labfiles70.zip to your C:\ (your root) drive

What you should be able to do
At the end of this lab you should be able to:
e Import FTP adapter RAR file into WebSphere Integration Developer
e Use External Service wizard to configure Activation Spec Properties, Resource Adapter Properties to
generate Business Objects and other artifacts and then configure Function Selector, Data Binding and
Data Handlers

e Deploy the adapter application onto WebSphere Process Server

e Test the deployed application using WebSphere Process Server test environment for both pass-
through and non pass-through using different scenarios and patterns

* Restore the server configuration
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Introduction

Archive Directory
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The backend EIS is the source of events. When events are generated at the EIS, files are created by
the EIS in the remote file system at a specific directory location. The same directory needs to be
configured by you as the Event Directory for the adapter.

The adapter polls event files, based on configured Event File Mask and FTP Get Quantity, from the Event
Directory and downloads to a Local Event Directory in the adapter machine for every FTP Poll Frequency
time and archives the file in FTP Archive Directory of the FTP server (it specified by you).

The adapter splits the downloaded event files from Local Event Directory based on the configured
SplittingFunctionClassname (splitting functionality) and SplitCriteria (splitting criteria used). User can
implement his/her own class which contains the splitting logic which splits the event files into individual
Business Objects. The adapter provides a Java™ interface which you have to implement in a class.

An entry is made in the Event Persistence table (given by EPEventTableName) for each BO with status as
New Event. The adapter sends the record chunk, through a Function Selector and Data Binding, to the
endpoint and the status in the Event Persistence table is updated based on successful (to PROCESSED
state) or failed(to FAILED state) delivery to the endpoint. The event management framework takes care of
delivering the event only once to the endpoint.

If archiving is enabled (if LocalArchiveDirectory has a valid value), the Business Objects are also archived
in a configured Local Archive Directory, on the local file system, based on successful or failed delivery to
the endpoint. Successful and failed events are written to different files. The entries from the Event
Persistence table are deleted for each of the successfully processed BO’s only. If Local ArchiveDirectory is
not set, the event file is deleted after processing of all the BO’s is completed.

If EventContentType in the Activation Spec Properties is not set or if it is not valid or the value does not
match the entries present in annotation of the Wrapper data object then it is called PassThrough and data
transformation will not happen in this case. During PassThrough the SplittingFunctionClassName and
SplitCriteria are set to values (even if they are set to different values) such that splitting happens based on
file size. In the PassThrough scenario you can have either Chunking or FilePassbyReference features.

Exercise instructions

Some instructions in this lab are Windows operating-system specific. If you plan on running the lab on an
operating-system other than Windows, you will need to run the appropriate commands, and use
appropriate files ( .sh or .bat) for your operating system. The directory locations are specified in the lab
instructions using symbolic references, as follows:
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<WID_HOME> C:\Program Files\\IBM\WID70

<FTPADAPTER_HOME> | <WID_HOME>\ResourceAdapters\FTP_7.0.0.0\deploy

<LAB_FILES> C:\Labfiles70 /tmp/Labfiles70

<WORKSPACE> <LAB_FILES>\FTPInbound\workspace

<LOCAL_EVENT_DIR> <LAB_FILES>\FTPInbound\LocalEventDir

<LOCAL_ARCHIVE_DIR> | <LAB_FILES>\FTPInbound\LocalArchivetDir

<FTPFILES> <LAB_FILES>\FTPFiles

<TEMP> C:\temp ftmp

Windows users’ note: When directory locations are passed as parameters to a Java program such as
EJBdeploy or wsadmin, it is necessary to replace the backslashes with forward slashes to follow the Java
convention. For example, replace C:\Labfiles70\ with C:/Labfiles70/.

Instructions if using a remote server for testing

Note that the previous table is relative to where you are running WebSphere Integration Developer. The table
below is related to where you are running the remote test environment:

<SERVER_NAME> serverl sssr011

<WAS_HOME> C:\Program letc/sscell/AppServer
Files\IBM\WebSphere\AppServer

<HOSTNAME> localhost mvsxxx.rtp.raleigh.ibm.com

<SOAP_PORT> 8880 8880

<TELNET_PORT> N/A 1023

<PROFILE_NAME> AppSrvol default

<USERID> N/A ssadmin

<PASSWORD> N/A frlday

Instructions for using a remote testing environment, such as z/OS, AIX or Solaris, can be found at the end
of this document, in the section “Task: Adding remote server to WebSphere Integration Developer
test environment”.
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Part 1: Initialize the workspace and prepare for the lab

This part of the lab, you will start the WebSphere Integration Developer V6.2 with a new workspace and
create required data source and database using the administrator console of WebSphere Process Server
V6.1

1. Extract the provided Labfiles70.zip to your C:\ (root) drive, if you have not already done so. This will
create the necessary subdirectory structure to complete the lab, and provides you with sample text
files

2. Start the WebSphere Integration Developer V7.0 with a new workspace

__a. Select Start > All Programs > IBM WebSphere Integration Developer > IBM WebSphere
Integration Developer V7.0 > WebSphere Integration Developer V7.0

___b. From the Workspace Launcher window, enter <WORKSPACE> for the Workspace field

g+ Workspace Launcher |

Select a workspace

IEM WehSphere Integration Developer 7.0 stares your projects in a folder called a workspace.
hoose a workspace folder to use For this session,

Warkspace: I ZtiLabfiles700\FTPINboundworkspace j Browse. .. |

(7) | Ok I Cancel

3. Click the & button on the right corner to close the Welcome page and proceed with the workbench

4. Follow the instructions of ‘Configure data source’ task with these inputs and create the data
source and data base required for this lab:

___a. Data source name: FTP
___b. JNDI name: jdbc/FTP
___c. Database name: FTPDB
5. Create directory structure on your FTP Server
___a. Log onto FTP machine/FTP Server using your ftp user and its password
__b. Create an EventDir and an ArchiveDir under the user’'s home directory:
1) mkdir EventDir

2) mkdir ArchiveDir
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1.1.

Review new properties

This part of the lab will give you brief description of some the new properties that are not used in this lab.

e New in V7.0: FTPS Connection mode: Specify the connection mode (Implicit or Explicit) to define the
data protection level with which the data is transferred between the client and the server can be
configured.

(0]

Explicit — In an explicit mode, the connection begins with an unencrypted FTP connection.
When any sensitive information such as password needs to be sent, the client explicitly issues
a request to switch to a secure FTP connection. After the successful SSL negotiation, a
secure command channel is established between the client and the server. Explicit mode
works with the default port 21 and is compliant with RFC 2228 commands. RFC 2228
specifies the mechanism for authenticating connections and confidential data transfer between
the client and the server and this is referred as explicit mode. The AUTH command is used for
specifying the security mechanism for the explicit mode. The client sends AUTH command
(AUTH SSL/TLS) to the FTPS server and switches to a secure command connection.

Implicit — In an implicit mode, the communication between the client and server is setup
immediately in secure mode. The text information exchanged between the client and server is
in an encrypted form. The default port for implicit mode is 990.

e New in V7.0: Data channel protection level:

(0]

(0]

Private — Data is transferred in encrypted form: Select Private, if the data transfer between the
Adapter and the FTPS server should be in an encrypted form

Clear — Data is transferred as clear text: Select Clear, if the data transfer between the Adapter
and the FTPS server should be in clear text form

Note: The default value is set to Private

Note: Server authentication can be enabled while establishing a SSL connection. While using SSL,
FTPS server sends its certificate to the FTP client for verification. The FTP client verifies the certificate to
ascertain that it is communicating with the intended FTP server. To enable this verification process, the
FTP server's certificate should be present in the client's trust store. Following three properties are used for
this server authentication.

e New in V7.0: Keystore type: Specify type of the keystore

(o}
(o}

JKS
PKCS12

Note: Use keytool utility, if you want to import server's certificate into client's trust store. For example, enter
the command keytool -import -v -alias serverCert -file server.cert -keystore clientTrustStore where
server.cert is the certificate of the server and clientTrustStore is the trust store of the client. Ensure that the
value of Keystore type property is same as the type used while creating the keystore.

< New in V7.0: Truststore file*: Specify the path of the truststore file that contains the certificates of the
servers trusted by the adapter

e New in V7.0: Truststore password: Specify the password of the truststore. It is used to check the
integrity of the truststore data. If the value is not specified, the integrity check is not performed. It is
applicable only if the protocol value is set to FTP over SSL or FTP over TLS
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Note: Client authentication can be enabled while establishing a SSL connection. When using SSL/TLS,
FTPS server requests for the client's certificate. The FTPS server verifies the certificate sent by the client
to ascertain that it is communicating with the intended client. To enable this verification process, the FTPS
server has to support client authentication and the client's certificate should be present at the server's trust
store. At the client's end, client's keystore information has to be available for the exchange of the certificate
to take place. Following three properties are used for this client authentication along with the Keystore

type.

< New in V7.0: Keystore file: Specify the path of the keystore file. The keystore file will contain the
private key entry of the FTPS client. It is also accompanied by a certificate chain for the corresponding
public key

e New in V7.0: Keystore password: Specifiy the password of the keystore. It is used to check the
integrity of the keystore data. If the value is not specified, integrity check is not executed. It is
applicable only if the protocol value is set to FTP over SSL or FTP over TLS

e New in V7.0: Key password: Set the Key password to the password provided while creating the key
in the keystore. This value is required to extract the certificate from the keystore while establishing a
SSL connection.

Note: All these properties are applicable only if the protocol value is set to FTP over SSL or FTP over TLS

e New In V7.0: Enable remote verification: It checks whether the control and data connections are
established with the same host (typically the machine from which you establish a connection to the
FTP server). If not, the connection fails. By default, Enable remote verification check box is selected.
This property is applicable to only FTP and FTPS protocols.
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Part 2: Pass through scenario

Inbound support can be broadly classified into two flows, one that involves data transformation and
another without it (pass-through). In this part of the lab, you will configure the pass through scenario using
the new External Service option from the WebSphere Integration Developer and then test the configuration
with different cases.

Pass through flow for the inbound scenario:

ActivationS pec properties
RA sets event data in the FTPInputStreamRecord instance

Polls containing: raw binary data for event
RAT

Since the datahandler property is not for the
databinding it instantiates UnstructuredContent

FS derives function name from the object
name passed in the Record instance.
Function name= emitFTPFile

UnstructuredContent

 Event data is picked from the event file based on SplitCriteria (it takes a value in bytes), converted
into a Input Stream and set on FTPInputStreamRecord.

e The protocol specific information like event file name, directory name are also set in the
FTPInputStreamRecord. If the PassThrough has a chunk file or if it is FilePassByReference or
default one is also indicated.

o0 In case of FilePassByReference the directory name corresponds to LocalArchiveDirectory
and file name to event file name appended with timestamp.

o In case of chunking the directory name indicates LocalEventDirectory, file name
represents event file name and ChunklInfo represents the chunk details.

0 In case of normal PassThrough the directory name indicates LocalEventDirectory and file
name represents the event file.
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e If the databinding does not contain information about the datahandler, then the inbound scenario is
considered as PassThrough.

e The FTPInputStreamRecord is sent to the base class and from there to the Function Selector. If no
matching DataBinding defined or the invoked DataBinding can not resolve to a BO, no content-
specific data binding is invoked but UnstructuredContent SDO is instantiated. It is set with byte
content present in the input stream object.

e Optionally the FTPFile wrapper is set with protocol specific information and UnstructuredContent is
set in FTPFile

e FTPFile wrapper is directly sent to the endpoint or the wrapper data object is set in FTPFileBG and
sent to the endpoint in case you want to use Business Graphs
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2.1. Configure pass through using external service wizard

In this part of the lab you will use this new external service feature to create and configure the function
selector, data binding and other required artifacts to test the inbound pass through scenario

1. Create the module: FTPPSInboundModule
___a. From the Business Integration window, right-click and select New > Module
___b. From the New Module window, enter FTPPSInboundModule for the Module Name

= New Module [_|O]

Create a Module _ J__|

Use a module ko inkegrate business applications and services, & module can conktain | .
any bype of component and can be deploved on WebSphere Process Server, D

Maodule name: | FTPPSInboundrModule

¥ Use default location

Locakion: | Zy\Labfiles 7OV FTPINboundlworkspace! FTPPSInboundrodule Browse. .. |

¥ open module assembly diagram

___c. Ensure that the box next to Open module assembly diagram is checked and then click Finish

You will now see a new module, FTPPSInboundModule, created from your Business Integration window
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2. To start External Service from the Palette:

___a. From the Palette on the left side of Assembly Diagram, click Inbound Adapters:

¢ s Palette

|Eui-,; (=] 5, [0

|~ Favarites

[.—= Components

(== Quthound Imports

[~ Inbound Exports

[== Cuthound Adapters

lc? Inbound Adapters

57 E-mail
=] Flak File
He FTP
'i}g iSerlg
-:'.@ 1o An expart companent which

connecks ko a remake file
e 10 Bsystem (FTP),

___b. Under Inbound Adapters, click the FTP and then click the empty canvas of the assembly
diagram. The New FTP File Service wizard is opened

3. From the New External Service window, expand Adapters > FTP and select Advanced: Create a
FTP service using the complete wizard

4+ New External Service | _ O] =]
Select the Service Type or Registry -
Select the bype of service ko create or reqgistry to browse, { 5

Filter: |tvpe filker et

Available bypes:
E @ Adapters
=-fte FTP
----- it dvanced: Create a FTP service using the complete wizard
e ﬁf Simple: Create an inbound FTP service to read From a remote File

Description:

Creates a service that reads from or writes to a file on a remote file system using the WebSphere® ;I
Adapker Far File Transfer Prakacol (FTP). ¥ou can create inkeqrated processes to access files managed by

the FTP server withouk special coding, During outbound processing, the adapter receives a request From

the module in the Form of a business object and then the adapter processes the request and returns the

result when applicable, in a business object, During inbound processing, the adapter polls a file syskem
associated with a FTP server for events at specified inkervals, When the adapter detects an event, it

requests a copy of the File, converts the file into a business object, and sends it ko the consuming service.

___a. Click Next

Note: You can also start the External Service from the File menu option:
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From the main menu, select File > New > External Service. This opens an External Service wizard that
helps you obtain a service which establishes connectivity with other systems. Select Adapters > FTP and
click Next

4. Onthe Select an Adapter screen, select IBM WebSphere Adapter for FTP (IBM : 7.0.0.0_IF01)
and click Next

i+ New External Service [_|O]

Select an Adapter

Select the wersion of the adapter that wou wank to use, \D

...... IETEM WebSphere Adapter For FTP (IBM @ 7.0.0.0_IF01)

5. Adapter Import screen:

In this step, you will import a connector resource adapter archive from the file system into your WebSphere
Integration Developer workspace. The adapter RAR file already exists under <FTPADAPTER_HOME>.

___a. The default Connector file is selected which is shipped along with WebSphere Integration
Developer

___b. Accept the default name for Connector project, CWYFT_FTPFile. You can change it to any other
name, but for this lab, you can leave the default name.

__c. For Target server, ensure that WebSphere Process Server v7.0 is selected

= New External Service [_|O]
Import a RAR File '

Import a resource adapter archive (RAR) From the file syskem to create a conneckar project :'l '
fFor the adapter. r

Archive File: CHIBMWID A ResourceddaptersiFTP_7.0.0.0_IFO1CWYFT_FTPFile.rar

Conneckar projeck: * IC'-.-'-.-'YFT_FTP'FiIe

Target runtime enviromenk: I'-.-'u'el::Sphere Process Server v7.0 j
___d. Click Next

Note: The resource adapter archive file is imported and a new connector project, CWYFT_FTPFile, is
listed under Business Integration view.

Note: If you are using the File menu option to start the External Service wizard, you are asked to select
the Processing Direction at this point. Select the radio button next to Inbound and click Next to proceed
to the next step.

6. Service Configuration Properties:
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___a. Deploy connector project: ensure that the default option With module for use by single
application is selected

__b. Enter these for FTP system connection information:

1) Host name: <FTP_Machine_Name> (or IP Address of the machine that has FTP Server),
for Ex: wsbetal49.austin.ibm.com

2) Remote directory: full path of the EventDir created in on the machine where FTP
server is existing (for Ex: /home/wsbeta/EventDir)

Note: This is the directory from where adapter gets the event files. Alternatively, you can also replace the
absolute directory path with WebSphere variables for the Event directory, Archive directory. Refer to ‘FTP
adapter — Processing COBOL copy book files lab’ for more details on this new feature introduced in
V6.2.

3) Local directory: <LOCAL_EVENT_DIR>

4) Protocol: FTP — file transfer protocol (default)

Note: Refer to ‘Install and configure SSH server’ for more details on SFTP — secure shell (SSH) file
transfer protocol.

5) Port number: 21 (default)

Deploy connector project: I'-.-'-.-'il:h module For use by single applicatiun-‘-j

Conneckion sethings: ILIse propetties below j

Connection propetties

FTP system connection information

Host name: # | wsbetal49, austin,ibm.com |

Remate direckary: | frootiDesktop/EventDir |

Local directary: = I :\LabFiles7 04 FTPInbound LocalEwentDir Browse, .,
Prokocol; IFTF‘ (File Transfer Prokocal) 'i—j
Pork nurmber: |21 A
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7. Rule Editor: Configure rules for event filtering

Note: You will configure three rules to match three different file name patterns. Adapter polls only those
files, which match the rule that is configured here.

___a. Define a rule to filter only .txt files:
1) Click Add... next to the Rule Editor table
2) From the Add/Edit window, provide the values as shown below:
a) Property Type: select FileName from the drop down list

b) Operator: select Matches_File_Pattern from the drop down list

c) Value: *.txt
& ndd/Edit I [=]

Add/Edit properties
Specify the properties,

Property tvpe: IFiIe narme Hﬂ
Cperatar; IMatches_FiIe_F‘attern -‘—j

‘alue: # I * kxk I

d) Click Finish

3) You should see a new rule entry in the table as shown below:

Rule editor to Filker files:

Cperator add. ..

File name Maktches File Patkern

Edit...

i

___b. Repeat the instructions listed in step 8.a and create two more rules as shown below:

Rule editor to Filker files;

| Property bype | Cperakor | Yalue | Add...
File name Matches_File_Pattern * bk
File name Matches_File_Patkern * bxkl Edit... |
| Filename | Makches File Pattern
Remowe |
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___c. Click Advanced >> to see the hidden advanced properties that can be configured:

b Event polling configuration

b Envent delivery configuration

b Ewent persiskence configuration

b Additional configuration

F FTP archiving configuration

b Socks proxy server connection information

F Secure configuration

} Bidi properties

[» Logging and tracing

You can click each of the configurations and review the options available under it. For this lab, you will
need only some of these properties.

___d. Event polling configuration: This has all the polling configuration details and for this lab, you can
accept the defaults.

__e. Event delivery configuration:

1) Ensure once-only event delivery: You should check this box only if you are using data
source and table name in the Event persistence configuration (below). If this property is set
to true, while using in-memory capability (explained below), the adapter will log a warning
message. By default this is selected and you can accept the default selection.

__f. Event persistence configuration:
1) Ensure that the Auto create event table is checked
2) Event recovery table name: FTPPSTABLE

3) Event recovery data source (JNDI) name: jdbc/FTP
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Note: This represents the JNDI name of the Data Source used by Event Persistence to get the JDBC
database connection. The Data Source must be created in the WebSphere Process Server. You should
enter the data source JNDI name that you created in Step 3 of Part 1.

[+ Event persistence configuration

G Auto create event table:

Event recovery table name: |FI'PPST.-5.ELEI

Event recovery data source (INDI) name: lju:ll:u:,"FI'F‘l
Iser name used to connect to event data source: I

Password used to connect to event data source:

Database schema name:

Note: The Event recovery data source (JNDI) name is not mandatory from V6.1. Now, the adapter can
use in-memory representation of event table to store all the necessary information. Adapter uses this
feature when event database information is not configured during inbound event polling. This feature will
not support the capability of handling “Ensure once-only event delivery”.

___g. Additional configuration:

1) New In V7.0: Enable remote verification: It checks whether the control and data
connections are established with the same host (typically the machine from which you
establish a connection to the FTP server). If not, the connection fails. By default, Enable
remote verification check box is selected. This property is applicable to only FTP and
FTPS protocols.

2) Pass only file name and directory, not the content (FilePassByReference): Accept the
defaults. This property determines if the adapter needs to load the contents of the file or
just provide information on the directoryName and fileName. If the value is true, the
adapter just provides the directory name and file name. This is not selected by default.

3) Include business object delimiter in the file content (IncludeEndBODelimiter): Accept
the defaults. When this property is set to true (selected) the delimiter (given in Split criteria)
is appended to the BO content before further processing is done. This property is valid only
if you are splitting the event files based on a delimiter, that is., only if the Split function
class name (below) is com.ibm.j2ca.utils.filesplit.SplitByDelimiter. This is not selected by
default.

4) Split function class name: Accept the defaults. This value takes a fully qualified class
name of the class to be used in order to split the event file. It takes two values as of now:

e com.ibm.j2ca.utils.filesplit.SplitBySize: a class which splits the event file based
on event file size. This is the default value for the split function class name.

« com.ibm.j2ca.utils.filesplit.SplitByDelimiter: a class which splits the event file
based on delimiter(used to separate BO's in event file)

The delimiter or file size is specified in split criteria attribute.

5) Specify the criteria to split file content: Accept the defaults. This attribute takes different
values based on value set in Split function class name.
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e If split function class name is set to com.ibm.j2ca.utils.filesplit.SplitBySize, then
split criteria must contain a valid number which represents the size in bytes. If
event file size is greater than this value, it is split into chunks of this value and so
many chunks are posted. If event file size is less than this value the entire event
file is posted in one shot. When split criteria=0 (default), chunking is disabled.

e If split function class name is set to
com.ibm.j2ca.utils. filesplit.SplitByDelimiter, then split criteria must contain the
delimiter which separates the BO’s in the event file.

Note: You will use the SplitByDelimiter class later in the content specific scenario.

__h. FTP archiving configuration:

1) Local Archive directory: click Browse... and select <LOCAL_ARCHIVE_DIR>

2) Remote archive directory: full path of the ArchiveDir created in on the machine where
FTP server is existing (for Ex: /home/wsbeta/ArchiveDir)

|~ FTP archiving configuration

To archive processed inbound event files on the local syskem, specify a local archive directory, To
archive files on the remate system For the inbound event Files downloaded ta the lacal syskem,
specify a remaote archive directory,

Local archive directory: | i Labfiles70VFTPINboundiLocalarchiveDir (_[M

File extension Far local archive: | ariginal

Success file extension faor local archive: | SUCCESS

Failure file extension For lacal archive: I Fail

Remoke archive directory: I {runt{DesktnELﬁ.rchiveDirl

File extension Far remote archive: I

8. Secure configuration: Refer to ‘Install and configure SSH server lab’ and ‘FTP Adapter — SFTP
support lab’ for more details on this new feature
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[+ Secure configuration

™ Enable remote server authentization for SETR protocal

Huost key: File: | Browse, ., |

Priwate ke Files | Browse. ..
Fassphirase; |

FTPS conmection mode: IEpriu:iI: j

[ata chanmnel probeckion level: IF‘rivate - Daka is transferred in encrypked Form j

Keystore bvpe: IJKS j

Truststore File: | BrowWse, . |
Truststore password; I

Keystare file: | Browse, ., |
Keystore password: I

Key password: |

9. Logging and tracing: Refer to the new lab ‘Log and confidential trace lab’ for more details on
this new feature

Adapter ID:+ | 001

[” Disguise user data as "<x%%" in log and trace Files,

10. For this lab, you are going to use the security properties from the activation specification.
___a. Select the check box next to Using security properties from the activation specification
___b. User name: username using which you connect to your FTP server (for Ex: root)

___c¢. Password: password for the user to connect to your FTP server

Setvice propetties
How dio wiou wank to specify the security credentials?
" Using an existing J&AS5 alias (recommended)

& Java Authentication and Authorization Services (1865) alias is the preferred methad,

J2T authentication daba entrys |

[F Ising security properties From the ackivation specificatinn]

The properties will be stored as plain text; no encrvplion is used.

User name: # I r':":'tl
Passwiord; o I ********I

™ Other

[ze if no security is required ar will Be handled By the EIS system, or the RER will be deployved an
e server and security will be specified By the properties in bhe WD laokup name.
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Function Selector Configuration: Function Selectors are required in order to map between events
generated by resource adapters and the appropriate SCA export function name.

There are two function selectors provided by the adapter foundation classes that are supported by the FTP
adapter - FilenameFunctionSelector and EmbeddedNameFunctionSelector.

FilenameFunctionSelector is used for generic FTP business object, where the object name cannot be
determined from the event file The FilenameFunctionSelector is a rule-based function selector that can
match a regular expression on a file name to an object name. This is represented in properties as a 2-
column table, with N rows. So, you can have a mapping as follows: For any event file with a .txt extension,
the corresponding object name is FTPBG. The endpoint method name generated by the function selector
in this case is emitFTPBG. You need to set this same name in the Native method property after you add
the operation.

You can also have same rules multiple times. If more than one rule matches, the function selector will
return the object name based on the first matching rule.

The function selector can be configured with multiple “rules”, each of which contains an object name, and
a regular expression to match against the file name. In the next part of this lab, you will create three such
rules.

11. Under Service properties, for Function selector options, select Use a function selector
configuration from the drop down menu

Note: If you select Use default function selector ‘FilenameFunctionSelector’ option for the Function
selector, the adapter automatically creates a function selector with FilenameFunctionSelector as the class
name. But, for this lab, you need to define three rules at the function selector and so you need to use the
‘Use a function selector configuration’ option.

i1se a funckion s

Function seleckar options;

Function seleckar; Mot defined Select, .. |

___a. Click Select next to Function selector. The Binding Resource Configuration window is opened

elector configuration

___b. Under ‘Use existing function selector from the list’, select FilenameFunctionSelector
properties
#= Function Selector Configuration M=] E3

Select a Function Selector

Select a function selector entry From the list, To use your own custom Function selector, select |
the second radio button o add wour cuskam Function selector, =l

{* Use existing Funckion selector from the lisk

___c. Click Next

2010 April, 09 IBM WebSphere Adapter 7.0 — Lab exercise Page 20 of 89

WBPMv70_AdapterFTPInboundLab.doc



© Copyright IBM Corporation 2010. All rights reserved

IBM WEBSPHERE ADAPTER 7.0 — LAB EXERCISE
12. Define Function selector rules: In this step, you will define three different rules and object names
associated with those rules.

When the adapter gets an event file, the function selector looks at the file type (ex: .txt, .tmp) and if
the type matches with any of the rules defined in this table, it will associate the corresponding

Object name of that rule to that event file.

FTPBG Jtxt | emitFTPFileBG emitFTPBG
FTPTypel | .*txtl emitFTPFilel emitFTPTypel
FTPType2 | .*txt2 emitFTPFile2 emitFTPType2

Note: Make a note of the Object name you specify here as you are going to use this in the later part
of the lab while specifying the EIS function name.

__a. Click Add... next to the Function selector rules table
___b. From the Add/Edit pop-up window, enter these:
1) Object name: FTPBG

2) Rule: *.txt

Ohiject name: IFI'PBG
Rule: [ . =txt

Note: You have now created a rule for the files of type .txt and an Object name, FTPBG, corresponding to
those file type

3) Click Finish from Add/Edit window
___C. The created rule is populated under Function selector rules:

Configuring function selector
Function selector rules:

___d. Repeat Steps 9.a and 9.b to add these function selector rules:

FTPTypel * ixtl

FTPType2 *.txt2

___e. You should see these three rules:
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Configuring function selector
Function selector rules:

Obiect name Fule Add...
FTFTypel CFwtl Edit... |
FTPEG et

__f. Click Next
___g. Ensure that the selected module is FTPPSInboundModule
___h. For Name, enter any string. For Ex: GenericFS

4+ Binding Resource Configuration M=l E3

New Function Selector Configuration

Create a new function selectar configuration, Specify the module, Folder, namespace, and |
name for the Function seleckor configuration, =

Module: IFTPPSInI:uDun::IMD::IuIe j Browse, .. | Tew, ., |

Mamespace: Ihttp:,l',l'FTPPSInI:uDundMD::IuIE v Default

Folder: I Browse. .. |
MName: I GenericFS I

__i. Click Finish
13. You will now be back to External Service window and the function selector created in these steps is
populated:
Function selectar options: Idse a Function selector configuration H
Function selectar: * (GEnericFS Aiff—— SElEct,

14. You can define data binding in two places - service level (current screen of External Service wizard)
or later at the method level (Operations screen of the External Service wizard). In this lab, you will
define data binding at the service level (from this screen)

___a. From the dropdown menu next to Data format options, select ‘Use a data binding
configuration for all operations’

Function selector options: IJse a Function selector configuration j

Function selectar: * GenericFS Select, ..

Drata Farmak: Mot defined Select, ..

Drata Farmak opkions: ilse a daka Format configuration For all operations

___b. Click Select... next to Data format. A Binding Resource Configuration window is opened

___C. Select the radio button for ‘Use existing data format transformation from the list’ and then
select FTPFileBaseDataBinding
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= Data Binding Configuration

Select Data Format Transformation

Select a data Format transformation entry From the list, IF wou want to use wour own custom |
daka transformation then select the second radio butkon to add wour custom transformation, =

{* Use existing data format transformation from the list

FTPFileBaselataBinding

___d. Click Next

Note: Data Handler Configuration: Since you are doing the pass through scenario, you do not need to
configure any data handler.
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___e. Click Next from the Data Transformation Properties screen

4= Data Binding Configuration

Data Transformation Properties

Specify the properties for the data transformation, L

Select DataBinding if wou want ko use a data binding developed For earlier versions of the adapter.

Binding kype: DataHandler j

Configured daka handler: Mok defined

Configured data binding: Mok defined Seleck, ., |

___f. Note that the selected module is FTPPSInboundModule

1) For the Name, enter FTPPSDB

4= Binding Resource Configuration H[=]

New Data Transformation Configuration

Create a new data transformation configuration. Specify the module, Folder, |
namespace, and name for the data transformation configuration. .

Module: IFTPPSIanundMDduIE j Browse, ., | MEW, ., |

Mamespace: Ihttp:,l',l'FTF'F'SInI:u:-unu:IM::u:IuIe V¥ Default

Folder: I Browse, ., |
Marme: I FTPPSDE I

2) Click Finish

___g. Now the FTPPSDB should be displayed for Data format

Draka Format options: Ilse a data format configuration for all operations +j

Diata Farmat: * FTPPSDE Al Scleck, .

15. Check the box next to Change logging properties for wizard to view the output location of the log
file and the logging level. You can change the logging level using the drop down menu.

___a. Click Next
Following screen is the Operations screen where you can define all your operations.
From V6.1, you can select from three different Data types for any operation:
e User defined type
e Generic FTP business object
e Generic FTP business object with business graph
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The pass through scenario of this lab demonstrates the creation of three operations (for the three rules you
have defined in the previous steps) using the Generic FTPFile business object and Generic FTPFile business
object with business graph data types.

Add emitFTPFileBG Operation:
16. From the Operations screen, click Add...

___a. Add Operation window is opened. Select Generic FTP business object with business graph
for the Data type and click Next

Operation properkies

The data bype For the operation input: | SR ) A N e
You are now back to Operation window and because you have chosen the data type with business
graph, the Input type is populated as FTPFileBG
___b. For Operation name, enter any name, for Ex: emitFTPFileBG
Define Data format:
___c. For Data format options, select Use a data binding configuration from the drop down list
___d. Click Select... next to Data format. A Binding Resource Configuration window is opened

___e. Ensure that the radio button for ‘Use existing data format transformation from the list’ and then
select FTPFileBaseDataBinding > FTPPSDB

+= Data Binding Configuration

Select Data Format Transformation

Select a data Format transformation entey From the list, IF you want ko use your own cuskom
data transformation then select the second radio button to add wour custom kransformation. =

¥ Use existing data format transformation from the list

H
= 2 FTPFleBaseDataBinding
ol T
1) Click Finish
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___f. Now the FTPPSDB is displayed for Data format in the Add Operation window:

#4= Add Dperation [_ | O]
Operation
Specify the properties For the operation bo add, \:j i
s ||

Operakion name: * I emitFTPFileBG I

Specify the aperation inpuk

Input Evpe: IFTF‘FiIeEG {htkpe ) fenana ibrn, cornyxminsprodfwebsphen Browse. .. | [det,., |
Draka Format options: ILIse a data Format configuration -‘—j
Data Format: * FTPPSDE My SilECL I

___g. Click Finish. The defined operation, emitFTPFileBG, is populated under Operations list

Operations:
el critF TPFileBGE ({http:/fivwew.ibm . comxmins/prod fwebsphere fj 2ca ffip ffpfilebglFTPFiIBE) @ void Add... i

Edit...

Remove

N
oo

Add emitFTPFilel Operation:
17. From the Operations screen, click Add...

___a. Select Generic FTP business object for the Data type and click Next

Operation properties

The data tvpe For the operation input: [EEnRlaN e g o =

You are now back to Operation window and because you have chosen the data type with no business
graph, the Input type is populated as FTPFile

___b. For Operation name, enter emitFTPFilel

___c. Follow the instructions used to define data format for emitFlatFileBG in the previous step, and
select the same FTPPSDB as Data format
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___d. Now the FTPPSDB is displayed for Data format in the Add Operation window:

Operation name: * I emitFTF‘FiIelI

Specify the operakion inpuk

Input Evpe; |FTF‘FiIe {hktp: v, ibrn, comyxmins/prodfwebspherefy.  Browse, .. | [ |
Data Farmat opkions: ILIse a data Farmat configuratian -‘—j
[rata Farmat * FTPPSCE Af— Select,,,

___e. Click Finish. The defined operations, emitFTPFilel, is populated under Operations list

Operations:

. emitFTPFileBG ({hitp: /fwwewe.ibm, comfxminsprod/websphere fi2ca ffip ffipfilebg}FTPFileBG) @ void
w0 emitFTPFile 1 (fhttp:/jwww.ibm. com/xmins prod fwebsphere fi2ca/ftp fpfile }FTRFE) @ void

Edit. ..

Remove |

Add emitFTPFile2 Operation
18. Repeat steps of Add emitFTPFilel to add one more operation, emitFTPFile2, with these changes:

___a. Operation Name: emitFTPFile2

Ciperakion name: * I emitFTF‘FiIeEI

Specify the operakion inpuk

Input Evpe: |FTF'FiIE $hiktp: v b, comxmins/prodiwebsphere i Browse, .. | T ., |
[rata Format opkions: ILIse a data Format configuration -‘—j
Data format: * FTPPSDE - Select...

19. Click Finish. The defined operations, emitFTPFile2, is populated under Operations list

Operations:
= emitFTPFileBG ({http: /fwww.ibm.comfxmins/prod/websphere fj2ca/fip/fipfilebg}FTPFleBGE) : woid Add... i
----- emitFTPFile 1 ({http:/fwwew.ibm. comfxmins fprod fwebsphere fi2ca ffip fpfle}FTPFile) : void :
il emitFTPFile2 ({hittp: ffwww.ibm.com xmins/prod jwebsphere fi2ca /fipfofileFTRFile) : void Edit... |

Remove |

___a. Click Next from Operations screen
20. From Generate Artifacts screen:

___a. For Name, enter FTPPSInboundIinterface
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= External Service =]

Generate Service
Specify the name and location of the new service and its interface, — I

Properties for service
Module; IFTF‘P‘SInI:u:uunu:IM-:u:IuIe j eV, . |

Mamespace: |http:,I',I'FTPF‘SInI:-DundMDduIe,I'FTPF'SInI:n:nunu:IInterFan:e

¥ Use default namespace

Mame: # I FTPPSINnboundInterface slf—

Descripkion: |

___b. Click Finish

21. The Assembly diagram for FTPPSInboundModule is opened with an Export component,
FTPPSInboundinterface:

' i
'~ | *FTPPSInboundModule - Assembly Diagram &3

b

d e Palette

NEoEE s
=

Fawvorites

¢"’i| ftp FTPPSInboundInterface

___a. Save (Ctrl + S) changes to your assembly diagram

Note: You need to manually change the Native method names.

The table below summarizes the rules, operations you have defined so far in this lab. Note the last column,
which shows the Native method name for each of the rule and operation defined:

Object Name | Rule | Operation Name | Native method name = emit + Object Name
FTPBG Htxt | emitFTPFileBG emitFTPBG
FTPTypel | *txtl emitFTPFilel emitFTPTypel
FTPType2 | *txt2 | emitFTPFile2 emitFTPType2

22. Change the Native method binding name
___a. Ensure that the FTPPSInboundinterface is selected from the Assembly diagram
___b. From the bottom panel, select Properties > Binding > Method bindings
___¢. From the Bound Methods list, click emitFTPFileBG

__d. From the right side, ensure that the Generic tab is selected, and then change the Native method
to emitFTPBG
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T Properties &3

[L F‘ru:ul:ulemsw Server Logs ik Servers} Fﬂ Asset Repnsitnries}

Ftp Export: FTPPSInboundInterface (EIS Binding)

Descripkion

= Bound Methods GENEric ] Cata Serialization |

Details

| emitFTF‘FiIeBGI
ﬁ emitFTPFile1 Bind method

Qualifiers

Binding

8 emitFTPFileZ Mative method: enmitFTPEG

End-point configuration

Method binding description:

I Method bindings I

___e. From the Bound Methods list, click emitFTPFilel

___f. Similarly, for emitFTPFilel, change the Native method to emitFTPTypel

= Bound Methods
-4 emitFTPFileBG
..... % emitFTPFile 1 Bind method

8% emitFTPFile2

Generic ] Data Serialization |

Mative method: emitFTPType 1

Method binding description:

___g. Similarly, for emitFTPFile2, change the Native method to emitFTPType2

Bl Bound Methods

-4 emitFTPFieBG

Generi-:] Data Serialization |

s ﬁ emitFTPFile 1 Bind method
- 83l emitFTPFile2 MNative method: emitFTFType
Method binding description:

___h. Save (Ctrl + S) your changes
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23. Review the FTPPSInboundModule: The generated Data Types, Interface, and Function selector

(GenericFS) and Data binding (FTPPSDB) under Configured Resources can be found inside
FTPPSInboundModule

EE FTPPSInboundModule
Elf;cﬂ Assembly Diagram

- {-ﬁ-!' FTPPSInboundInterface

----- @E Dependencies

EEI---J;"E_= Business Logic

El*'f‘—t" Data Types

Elzf';' Common3chemas

L|FTEFile

FTPFileBG
“ Il unstructuredContent

El- @ Interfaces
fo @:[ FTPPaInboundInterface I
..... Y Mapping

=08 Configured Resources

O FreesDE

enericFS

You can open each of these generated artifacts and business objects and review the properties inside.

Review the created methods inside the interface:

___a. From the Business Integration view, expand FTPPSInboundModule > Interfaces and then
double-click FTPPSInboundinterface to open it

__b. You should see these three operations:

=
@ FTPPSInboundInterface &3

*Interface EE
Configuration
Mame FTPPSInboundinkerface Refactor name

Mamespace | http:/(FTPPSInboundMadule/FTPPSInboundInkerface

Refactor namespace

Binding Skyle | docurment literal wrapped

iZhange binding skvle ko document literal non-wrapped  Mare. .

rDOperations

¥L o PP N

Dperations and their parameters

| Mame | Type
v %3 emitFTPFileBis
1 Inputs | emitFTPFileBGInpLE | FTPFileBG
v %z emitFTPFile1
1 Inputs | emtFTPFilet Input [FTPFie
w iz emitFTPFilez
1 Inputs | emitFTPFil2Input [FTPFie
___C. Close the interface, FTPPSInboundinterface
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2.2. Add Java component

In this part of the lab, you will add a Java component and then wire the component to the existing Export
interface. The Java component is your endpoint.
1. Open the assembly diagram for FTPPSInboundModule (if it is already not open)

___a. From the business integration view, expand FTPPSInboundModule and double click Assembly
diagram

2. Drop a Java component to onto the assembly diagram

___a. From the Palette, click Components to expand it

-
?81 FTPPSInboundModule

¢ e Palette

NEEEE

[~ Favarites

[= Components

'-_'é Untyped Component
5 Human Task,

Ll Media%n Flow

2 Proceld2vd

= Rule Graup

___b. Click Java and then click the empty space of FTPPSInboundModule assembly diagram. This will
place a new component, Componentl on the assembly diagram.

3.  Wire the FTPPSInboundinterface to the Componentl
___a. Select the wire (EL:) icon from the Palette
___b. Click FTPPSInboundInterface and then click Component1 to wire them together

___C. Select OK for the Add Wire pop-up window:
4= add Wire ]|

This ackion will allow the target service to be used in other modules, The
\:I) service interface from the export will be added to the target. Do wou want ko
conkinue?

™ Always create without prompt

Cancel |

___d. From the top of the Palette, click the Selection Tool icon ( [%) to get back to the normal cursor
mode
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___e. Right-click the empty space of the Assembly diagram and select Arrange Contents
Automatically from the pop-up menu. Your assembly diagram for FTPPSInboundModule will
look like this:

TSI *FTPPSInboundMadule - Assembly Diagram &3

¢ o Palette

NEEEYE

[ Favorites @ #p FTPPSInboundInkerface @ '}.ﬂ Caomponent 1
f .-

___f. Right-click Componentl and select Generate Implementation from the pop-up menu
___g- On the Generate Implementation panel, select default package, and click OK

__h. Componentlimpl.java is opened in Assembly editor. Scroll down to the method
emitFTPFileBG that needs to be implemented and add this code under that method:

System.out .printIn(""****Inside emitFTPFileBG: type .txt Files****');
___i. Similarly add the print statement to emitFTPFilel method:

System.out .printIn(""****Inside emitFTPFilel: type .txtl Ffiles****'");
___j- And finally, add the print statement to emitFTPFile2 method:

System.out .printIn(""****Inside emitFTPFile2: type .txt2 files****'");
___k. Save (Ctrl + S) and close Componentlimpl.java

___|. Save (Ctrl + S) and close Assembly diagram: FTPPSInboundModule
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2.3. Test pass through scenario

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the Pass through scenario.

1. Add the project to the WebSphere Test Environment server

a. Right-click WebSphere Process Server v7.0 under the Servers view and select Add and
remove projects... from the pop-up menu

b. From the Add and Remove Projects window, select FTPPSInboundModuleApp under Available
projects panel and click Add >

c. You will now see the FTPPSInboundModuleApp added to the Configured projects

d. Click Finish and wait until the project is being published onto the server. The server is started in
Debug mode if it is not already started before

2. Test the application by providing three different input files:

Note: For your convenience, three test files, sample.txt, sample.txtl, sample.txt2 are placed in
<FTPFILES>.

Test scenario 1: .txt files

___a. On the machine where the FTP Server is running, put sample.txt file in the EventDir. The
adapter will poll the copied file from the event directory and will transfer it to the archive directory

___b. Because you have placed a .txt file, it will pass through the emitFTPFileBG method and you
should see this message in your Server Logs view (or SystemOut.log):

£8 Task Flows | 2 Build Activities | ) Properties |2 Problems [ 72 Server Logs 52 . # Servers | [ Asset Repositories | B Console | -
ZRdE AR N=NEN 2 Y

Welcome WebSphere Process Server v7.0 atlocalhost 22 ]
Console (filtered): WebSphere Process Server v7.0 at localhost

Showe Al Record Types (Hierarchical) = with only Server State and Error Contents (Page 1 of 13

___¢. Check the <LOCAL_EVENT_DIR> on your local machine. The file is quickly moved from this
directory to the local archive directory

___d. Check the ArchiveDir of your FTP server which should contain the same file name appended
with year, month, date, system time, and processed as you have given

___e. Check the <LOCAL_ARCHIVE_DIR> subdirectory which should contain an archive of the event
file, with the same file name appended with year, month, date, system time, and success

Address Iﬁ C AL abfiles 700WFTPINboLndy_ocalArchivelir j o

Falders * || Mame | Size | Type

= I3 FTPInbound - 1KB SUCCESS Fie
i LocalArchiveDir
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Test scenario 2: .txtl files:

___f. On the machine where the FTP Server is running, put sample.txtl file in the EventDir. The
adapter will poll the copied file from the event directory and will transfer it to the archive directory

___ 0. Because you have placed a .txt1 file, it will pass through the emitFTPFilel method and you
should see this message in your Server Logs view (or SystemOut.log):

Type | ~ Time |Thread D |Contents |
0= Log message  Oct 26, 2009 16:49:1,,, Q0000105 | Aeksckdstckiokngide emitFTPRIeBG, Type et filegittotokaotorsok

HP Logme e [Oct 26 03 16:53:2... | 00000105 | * side emitFTRFile 1 typ

___h. Check the <LOCAL_EVENT_DIR> on your local machine. The file is quickly moved from this
directory to the local archive directory

___i. Check the ArchiveDir of your FTP server which should contain the same file name appended
with year, month, date, system time, and processed as you have given

___j. Check the <LOCAL_ARCHIVE_DIR> subdirectory which should contain an archive of the event
file, with the same file name appended with year, month, date, system time, and success

Address |1:| C L abfles FONFTRINboUnd L ocalArchivelir j 50 |
Falders 2 Size | Type
= [ FTPInbound ﬂ ST £ L ] 1KB SUCCESS File
3 LocalArchiveDir |ﬂsample.t><t_2009_10_26_16_49_19_5 15,501C0ess 1KB SLUCCESS File

Test scenario: .txt2 files:

___k. On the machine where the FTP Server is running, put sample.txt2 file in the EventDir. The
adapter will poll the copied file from the event directory and will transfer it to the archive directory

___|. Because you have placed a .txt2 file, it will pass through the emitFTPType2 method and you
should see this message in your Server Logs view (or SystemOut.log):

Type | =~ Time |Thread IC |Contents |
05 Log message | ©ct 26, 2009 16:49: 1., 00000105 kot ngde emitF TPRIEBE: type bt flagtktobiook
= Log message Oct 26, 2009 16:53:2... 00000 105 Aok EARR s de emitFTRFle 1itype otl fllaghaokaortkaok

side emitFTRFileZ

___m. Check the <LOCAL_EVENT_DIR> on your local machine. The file is quickly moved from this
directory to the local archive directory

___n. Check the ArchiveDir of your FTP server which should contain the same file name appended
with year, month, date, system time, and processed as you have given:

B Location: | 5] file:/maot/De skio /A hive Dir

] audio CD Browser

+ : t] Device s 2
‘i".ll%]‘F‘:'"ts isampl&.t&tl_
+-{& Print System Browser R s=rmple._2000_12_07_13_26_
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___ 0. Check the <LOCAL_ARCHIVE_DIR> subdirectory which should contain an archive of the event
file, with the same file name appended with year, month, date, system time, and success

Address |5 C\Labfiles 70\ TRINboUnd\LocalArchiveDir

jGo

Size | TYpe

|ﬂ sample txt1_2009_10_26_16_53_29_750.50ccess

Iﬂ sample txt_200%_10_26_16_49_19_515.success

1KB SUCCESS File
1KB SUCCESS File
1KB SUCCESS File

___a. Right-click WebSphere Process Server v7.0 under the Servers view and select Add and

__b. Select FTPPSInboundModuleApp under Configured projects and click < Remove

___c. Click Finish after you see the application moved to Available projects. Wait until the application

IBM WebSphere Adapter 7.0 — Lab exercise

Folders * || Mame
= 5 FTRInbound -
7 LocaltrchiveDir
I LocalEventDir
3. Restore the Sever Configuration
remove projects... from the pop-up menu
is being unpublished
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2.4. Test pass through scenario with SplitBySize

In this last part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the pass through scenario with split by size.

1. Configure/change the adapter properties from the Properties view:
__a. Change to Business Integration perspective if you are in a different perspective
1) Select Window > Open Perspective > Other...
2) From the Select Perspective window, select Business Integration (default) and click OK

b. Expand FTPPSInboundModule and double-click FTPPSInboundModule to open it in Assembly
Editor

c. Click FTPPSInboundIinterface from the Assembly Editor and select Properties tab from the
bottom

d. Select Binding under Properties and select End-point configuration under Binding itself and
then select the Connection tab

e. Now under ActivationSpec Properties, you can review the properties that were given during
the external service wizard

__f. Scroll down to Advanced Properties
1) File transfer type: select ascii from the drop down list
2) Select the box for ‘Split file content based on the size (bytes) or delimiter’
3) Split function class name: com.ibm.j2ca.utils.filesplit.SplitBySize (default)

4) Specify criteria to split file content: 1000
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Note: The value, 1000, you entered for the field, Specify criteria to split the content, is the size of the input
file in Bytes.

[ﬁ.dditional cnnfiguratiunl

Reatriave files wilh EE pattarn. e

Sort event fias: no sort =]
Enabia remote verficalion

Encoding wsed by FTP sarver!
Fie content encoding:
FIF sapver connection moga. active |E|

Ffle fransfar fypa. [~]

Number of Fies Eo gaf af a time. 10

Ambear of poff pariods befwean fha donnibact: 5

FPopuiate he full guatified dass name of Ehe cusfom parser Bhal & ured fo parse the e - outiput. THis i wred ol when e I - outout deviafes fom
standard oufout,

Custam parsar class namea. Browse, .,
O Faszs oniy file name and girectory, nof the content
O mciugie busness abjact delmder i te A confant

Spit Aie confent bazed on the mize (bytes) or delmiter. I

SnfE functian clase nama. [cnm.ibm.j2ca.utils.FiIespIit.SplitBySizeI Browise, .,

Specify ctera fo 5ot file confant:

Ruin TP scripé e before donnioading fies: | Browse. ..

Run FTRP soqpé file affer downdoading flas: . Browse. .,

___g. Click Assembly diagram (or any where else so that the save button is enabled) and then save
(Ctrl +S) your changes

2. Modify Java code:
___a. From the assembly diagram of FTPPSInboundModule, double-click Componentl

___b. Componentlimpl.java is opened in Assembly editor. Scroll down to the method
emitFTPFileBG that needs to be implemented and add this code under that method:
System.out .printIn('******x****Inside emitFTPFileBG: type .txt

= iy .

DataObject FTPFile = emitFTPFileBGlnput.getDataObject("'FTPFile™);
DataObject Unstructured = FTPFile.getDataObject(*'Content');
String astext = Unstructured.getString("'AsText");

System.out .printIn("'File content----- > "+astext);

Note: You can also copy the Java code from <FTPFILES>\SplitBySizeJavaCode.txt.

___C. Save (Ctrl + S) and close Componentlimpl.java
___d. Save (Ctrl + S) and close Assembly diagram: FTPPSInboundModule
3. Repeat Step 1 of part 2.3 to add the saved project FTPPSInboundModuleApp to the server
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4. Test the application with and input file larger than 1000 Bytes

Note: For your convenience, a test file SplitBySize.txt is placed in <FTPFILES>. The size of the file is
around 3KB.

___a. On the machine where the FTP Server is running, put SplitBySize.txt file in the EventDir. The
adapter will poll the copied file from the event directory and will transfer it to the archive directory

___b. Because you have placed a .txt file, it will pass through the emitFTPFileBG method and you
should see this message in your Server Logs view:

O = Log message Dec 16, 2005 15:45:02,593 00000090 wdkdk R  cide emitFTPRIlBG: bype (bxk  Filegtastsss
D |=' Log message Dec 16, 2008 15:45:02,593 Qoooao9a File contenk----- = SplitBySize kest content Seament 1;
O = Log message Dec 16, 2005 15:45:02.640 00000030 Aokt T cide emitFTPRiIlBG: bype (bxt  Filegkstekets
D =/ Log message Dec 16, 2005 15:45:02.640 0o0oao0 File conkenk----- = SplitBySize test content Seament 2;
O = Log message Dec 16, 2008 15:45:02,703 00000090 Akt nside emitFTPFileBE: tvpe bxb  Files¥trssrss
D =/ Log message Dec 16, 2005 15:45:02.703 0o0oao0 File content----- = SplitBySize test content Seament 3:

___ €. Open your SystemOut.log file located in <WID_HOME>\pfiwps\logs\serverl to see the complete
stack of messages:

[1/9/08 13:10:05:250 CST] 0000008d SystemOut Q wmwEmwAsrwERRInside emitFlatFileBG: type .LxXt Lilleswewsswsaasss 1=

[1/9/08 13:10:05:250 C3T] 000000Sd SystemOut O File content--—-—--— > BplitBySize test content Segment 1:
A T T T T T T T T T T T A T T A T T A A T A A T A A A A N A A N A T A T N A T A N A T A N A A A N A T A N A T A AN T AN AT T AT A TN AT AN ANANNALS

A R A A A A A A A A A N A A A R A A A R A A R T R A A A T A A A AT A A AR TR A AT AR AT EARATEAS
e L Y
R R R e L a
A R R A A A A A A A A A A A N T A A T A A R T R A A T R A A T A A AR T AR AT TR AT TR AT T T F

R R A A A A A A A A A N A A R A A A A A S A A R T R A A A T A A A AT A A AR TR AR AN AR AT EARATAAS

[1/9/08 13:10:05:281 CST] 00000091 SystemoOut O *rEFxARrEAAIn=ide emitFlatFileBG: type .txt files#ssdsrsrrsrs
[1/9/08 13:10:05:281 CST] 00000091 SystemOut 2 File content--—-—--— > BplitBy3Size test content Segment 2:
[1/9/08 13:10:05:312 C3T] 00000092 Systemout O wEEEEAEEEEsInside emitFlatFileBG: type .txt filegwrrssssasass
[1/9/08 13:10:05:312 C3T] 00000092 Systemout O File content--—-—--— > BplitBySize test content Segment 3:

3353355353535353353333533353533353353355353535353355335353553535335353533353533535333335333335333533535353533533553535353535353353333333533333353335335333533535335335353335333533
3353553533335 3 3333533333353 035303303553 5033503 303353533335 3333335333535 33533053353353553553533533 3333333333333 333 33333333333333333333333
3383535535553 5335353353335 3303353303535 353533553535 5553535535353 3535333530533 3530335335355 3533533553353 3353535333533 35 3533353333333 333333333333333
3303533533533 3333333533333 330330330350 353353350353535 3353353333353 3333303333033 5033533503333533533333 3333333333333 33533333333333333333333
3355533353000 38553 533553505353 055 535355355030 5553 305353555353 355 535305555033 555353533533 553353553 5359553533335553535353333335355535353353333333533335333333

Note: The same SplitBySize.txt file, if delivered without specifying Split criteria to 1000 (about 1KB), will
reach the end point only once. Here, in this part, you saw the successful event delivery message for three
times for the same file (with the file size being 3KB) because of the split criteria that has been given as
1KB, which means it splits the file into three parts and delivers to the endpoint.

__d. Check the <LOCAL_EVENT_DIR> on your local machine. The file is quickly moved from this
directory to the local archive directory

___e. Check the ArchiveDir of your FTP server which should contain the same file name appended
with year, month, date, system time, and processed as you have given
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___f. Check the <LOCAL_ARCHIVE_DIR> subdirectory which should contain an archive of the event
file, with the same file name appended with year, month, date, system time, and success:

Falders | Size: | Type

=] jj FTPInbound 3KB SUCCESS File

' LocalarchiveDir

___g. Restore the Sever Configuration: follow the instructions under Step 3 of Part 2.3
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Part 3: Content specific (non-pass through) scenario
Of the two flows, you have just tested the pass through scenario that does not involve data transformation.
In this part of the lab, you will configure the non-pass through scenario using the new External Service
option from the WebSphere Integration Developer and then test the configuration with different cases.

Content specific flow for the inbound scenario:

ActivationSpec properties _
RA sets event data in the FTPInputStreamPBecord

~— FPolis instance containing: raw binary data for event
FTP
.

FS checks for the datahandler in the
DataBinding. Uses SDO returned to derive
function name.

| Record already contains SO0 at this point.
: Invocation of DataBinding by EIS export has no
: impact.
I

CustomexWirapper or FIPFile

B F hc“g = emitCusto Wrapper or emitCustomer or emitF TPFile
Sales0rder

=

 Event data is picked from the event file based on SplitCriteria (it contains the delimiter which actually
separates the BQO’s in an event file), then converted into a input stream and then set on
FTPInputStreamRecord.

Motice the BO-specific SCA function name via
which this event is published.

e The data handler should be set with a valid value.

 Based on the wrapper generation selection, the protocol specific information such as event file name,
directory name (LocalEventDirectory) which needs to be sent to the endpoint is also set in the
FTPInputStreamRecord.

e The FTPInputStreamRecord is sent to the Function Selector. The Function Selector will invoke that
data binding and get back a content specific data object (Customer SDO). That is used to generate the
function name and emit that. If content-specific data binding is not valid, the Data Transformation
Framework will flag appropriate error.

e Optionally while sending protocol specific information like directoryName and fileName, you need the
wrapper data object to hold this.
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e This content specific data object is set on the wrapper data object if wrapper is used. Protocol specific
information is also set in the wrapper. The content specific data or wrapper is sent directly or wrapper
is setin a BG and sent to the end point.
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3.1. Configure content specific (non-pass through) scenario using
external service wizard

In this part of the lab you will use this new external service feature to create and configure the function
selector, data handler, and data binding and other required artifacts to test the inbound pass through
scenario

1. Create FTPCustominboundModule
___a. From the Business Integration window, right-click and select New > Module
__b. From the New Module window, enter FTPCustominboundModule for the Module Name
___c. Ensure that the box next to Open module assembly diagram is checked and then click Finish

You will now see a new module, FTPCustomInboundModule, created from your Business Integration
window

2. Import required business objects

New in V7.0: Wrapper business objects for the business objects containing global elements are supported in
this version. So, you can now pass the protocol specific information as part of each request.

___a. Expand FTPCustomInboundModule (if not already expanded), right-click Data Types and select
Import... from the pop-up menu

___b. From the Import window, expand General and select File System and then click Next
___c. Enter From directory

1) Click Browse... next to From directory

2) From the Import from directory window, select <FTPFILES> and click OK

Now, you will see FTPFiles folder added on the left side, and all the xsds and other files under that
folder on the right side.

___d. Select the box next to Customer.xsd and Order.xsd
__e. Ensure that the FTPCustominboundModule is selected for Into folder
___f. Click Finish from the Import window
The Business Integration window is updated with the imported business objects.
3. Review imported business objects:

___a. Expand FTPCustominboundModule > Data Types and you will now see two new data types
Customer and Order under it
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___b. Double-click Customer review the fields inside the object:

[ Custamer
= = Click to Filker, .. =

[&] CustomerMame skring

(e Address skring
[8] Cit skring
[e] Skate skring

4. Now, double-click Order and review the fields inside the object:

] Order

o «Click to Filer, . >
[8] OrderMumber string
[e] CrderType  string
[B] Quantity skring
[8] Price skring

5. After reviewing, close the Customer business object from the Assembly editor
6. To start External Service from the Palette:

___a. From the Palette on the left side of Assembly Diagram, click Inbound Adapters:

7. Under Inbound Adapters, click the FTP and then click the empty canvas of the assembly diagram.
The New FTP Service wizard is opened

8. From the New External Service window, expand Adapters > FTP and select Advanced: Create a
FTP service using the complete wizard
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¥ New External Service M=l
Select the Service Type or Reqgistry -
Select the bype of service to create or reqgistry to browse, { 3

Filter: Jbvpe filter bt

fvvailable bypes;

= @;‘ Adapters
=-fte FTP
S 0 anced: Create 3 FTP service using the complete wizard

E‘p" Simple: Create an inbound FTP service ko read From a remoke File

Description:

Creates a service that reads fram ar wrikes ba a file on a remaote File syskem using the WebSphere® ;I
Adapter for File Transfer Protocol (FTP), You can create inkegrated processes ko access files managed by

the FTP server without special coding. During outbound processing, the adapter receives a request From

the module in the Form of a business object and then the adapter processes the request and returns the

result when applicable, in a business object, During inbound processing, the adapter polls a file sywskem
associated with a FTP server for events at specified intervals, When the adapter detects an event, it

requests a copy of the file, converts the file into a business object, and sends it to the consuming service,

___a. Click Next

Note: You can also start the External Service from the File menu option:

From the main menu, select File > New > External Service. This opens an External Service wizard that
helps you obtain a service which establishes connectivity with other systems. Select Adapters > FTP and
click Next

9. Onthe Select an Adapter screen, expand IBM WebSphere Adapter for FTP (IBM : 7.0.0.0_IF01)
and select CWYFT_FTPFile

&

'l

___a. Click Next

Note: If you are using the File menu option to start the External Service wizard, you are asked to select
the Processing Direction at this point. Select the radio button next to Inbound and click Next to proceed
to the next step.

10. Service Configuration Properties:

___a. Deploy connector project: ensure that the default option With module for use by single
application is selected

___b. Enter these for FTP system connection information:
1) Host name: <FTP_Machine_Name> (or IP Address of the machine that has FTP Server),

for Ex: wsbhetal49.austin.ibm.com
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2) Remote directory: full path of the EventDir created in on the machine where FTP
server is existing (for Ex: /home/wsbeta/EventDir)

Note: This is the directory from where adapter gets the event files.

3) Local directory: <LOCAL_EVENT_DIR>
4) Protocol: FTP - file transfer protocol (default)

5) Port number: 21 (default)

Deploy connectar projeck: I'u'u'ith module For use by single applicatinn-(—j

Conneckion setkings: ILlse properties below j

Conneckion propetkies

FTP system connection information

Host name: # | wshetal49, austin,ibm.com |

Remote direckory:* [,l'ru:u:ut,l'Deskl:u:up,l'EventDirI

Local directary: = | Z:1Labfiles7 0 FTPINboundi LocalEventDir Browse, .,

Prokocal; IFTF‘ (File Transfer Protocol) "—j
Port number: | 2] i—

___c. Click Advanced >> to see the hidden advanced properties that can be configured:

You can click each of the configurations and review the options available under it. For this lab, you will
need only some of these properties.

___d. Event persistence configuration:
1) Ensure that the Auto create event table is checked
2) Event recovery table name: FTPCustomTable

3) Event recovery data source (JNDI) name: jdbc/FTP

Note: This represents the JNDI name of the Data Source used by Event Persistence to get the JDBC
database connection. The Data Source must be created in the WebSphere Process Server. You should
enter the data source JNDI name that you created in Step 3 of Part 1.

[ - . . 'I
w Event persistence configuration

[ fuko create everk kable!

Event recovery kable name: | FTPCustamTable

Event recovery data source (IMDI) name:; | jdbc/FTP

Iser name used ko connect to evenkt data source: |

Passwiord used to conneck to event data source: |

Database schema name: |
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Note: The Event recovery data source (JNDI) name is not mandatory from V6.1. Now, the adapter can
use in-memory representation of event table to store all the necessary information. Adapter uses this

feature when event database information is not configured during inbound event polling. This feature will
not support the capability of handling “Ensure once-only event delivery”.

___e. FTP archiving configuration:

1) Local Archive directory: click Browse... and select <LOCAL_ARCHIVE_DIR>

2) Remote archive directory: full path of the ArchiveDir created in on the machine where

FTP server is existing (for Ex: /Thome/wsbeta/ArchiveDir)

|~ FTP archiving configuration

To archive processed inbound event files on the local system, specify a local archive directory, To
archive files on the remate system for the inbound event files downloaded to the local syskem,

specify a remote archive directary.

Local archive directory: | 1\ Labfiles 70V FTPInboundiLocalArchiveDir (—[m

File extension for local archive: | ariginal

Success file extension Far local archive: I sUCCESS

Failure file extension for local archive: | Fail

Remote archive directory: I {runt{DesktDELﬁ.rchiveDirl

File extension for remote archive: |

11. Secure configuration: Refer to ‘Install and configure SSH server lab’ and ‘FTP Adapter — SFTP
support lab’ for more details on this new feature

| A .
» Secure configuration

2010 April, 09

" Enable remote server authentication For SETR protocal

Huost key: File: | Browse, ., |
Priwate ke Files | Browse. .. |
Fassphirase; |

FTPS conmection mode: IEpriu:iI: j

[ata chanmnel probeckion level: IF‘rivate - Daka is transferred in encrypked Form j

Keystore bvpe: IJKS j

Truststore File: | BrowWse, . |
Truststore password; I

Keystare file: | Browse, ., |
Keystore password: I

Key password: |
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12. Logging and tracing: Refer to the new lab ‘Log and confidential trace lab’ for more details on
this new feature

r

.....

Adapter ID:+ | 001

[ Disguise user data as "<%%" in log and trace Files.

13. For this lab, you are going to use the security properties from the activation specification.
___a. Select the check box next to Using security properties from the activation specification
___b. User name: username using which you connect to your FTP server (for Ex: root)

___c¢. Password: password for the user to connect to your FTP server

Setvice propetties
How do wou want ko specify the security credentials?
™ Using an existing J&A5 alias (recommended)

& Java futhentication and Authorization Services (1845) alias is the preferred method,

J2C authentication data entry: |

[F Ising security properties Fram the ackivation speciFicatiDnl

The propetties will be stared as plain text; no encryption is used,

Iser name: * I r':":'tl
Passward: e I ********I

i~ Other

[se if no security is required o will be handled by the EIS system, or the RER will be deployved on
the server and security. will be specified by the properties in the JWET lookup name.

Function Selector Configuration: Of the two function selectors that are supported by the FTP adapter,
FilenameFunctionSelector was used for pass through scenario. The EmbeddedNameFunctionSelector
is used in case of content-specific business objects, where the object name is embedded in the event file.
The EmbeddedNameFunctionSelector will return the function name based on the content data. For
example, if the content-specific business object is CustomerWrapperBG, the function returned by the
function selector is emitCustomer. This function selector should be configured with a data handler. The
data binding should be the adapter-specific WrapperDataBinding. The data binding should be configured
to use the same data handler configured with the function selector.

14. Under Service properties, for Function selector options, select Use a function selector
configuration from the drop down menu

Function seleckar options: IJ=e & function selector configuration -‘—j

Function seleckar; # Mok defined Seleck, .. |
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Note: If you select Use default function selector ‘FilenameFunctionSelector’ option for the Function
selector, the adapter automatically creates a function selector with FilenameFunctionSelector as the class
name. For non-pass through scenario, you need to define a function selector that uses
EmbeddedNameFunctionSelector.

___a. Click Select next to Function selector. The Binding Resource Configuration window is opened

___b. Under ‘Use existing function selector from the list’, select FilenameFunctionSelector
properties

#= Function Selector Configuration M=] E3
Select a Function Selector

Select a function seleckar entry Fram the lisk, Ta use wour awn custam Funckion seleckor, select |
the second radio button o add wour cuskam Function selector, =l

% se existing Funckion selector from the lisk

. Bl rmbed
Lo

“|8Z| RootMameFunctionSelector properties

dedhameFunctionSeleckar properties
FilenameFunctionSelector properties

___C. Click Next

Data handler configuration: The screen shown below is Function Selector Properties screen where
you will define the data handler and encoding used in inbound processing

___d. Click Select... next to Data handler configuration name. A Binding Resource Configuration
window is opened for you to define the data handler

___e. Under ‘Use existing data format transformation from the list’, select XML >
UTF8XMLDataHandler

Note: UTF8XMLDataHandler listed under XML is the predefined data handler with UTF-8 as the encoding.
You can also select XML and then select the encoding of your choice in the next screen to define a data
handler of your choice.
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#= Data Handler Configuration _ O]

Select a Data Format Transformation

Select a data Format transformation entry From the list, To use wour own custom data |
kransfaormation, select the second radio bukton to add wour custom transformation, =l

% |se existing data format transFormation from the list

-6 Delimited

B Fived Width

----- B2 Handled by wTx

= {2 Handled by WT Invoker
= {2 14%E based Java Bean
- fE 150N

FxMLDakaHandler

___f. Click Finish

___g. From the next screen, the Data handler configuration name, UTF8XMLDataHandler is displayed
which was selected in the previous steps

#% Function Selector Configuration =]

Function Selector Properties

Specify the properties For the function seleckar, |

Data handler configuration name: UTFSRMLDataHandler sl Select, .,

___h. Click Next

___i. From the New Function Selector Configuration screen, enter CustomFS for Name

#= Binding Resource Configuration =]

New Function Selector Configuration

Create a new Function selector configuration, Specify the module, folder, namespace, and |
name For the Function selector configuration. =l

Module: IFTF‘Custu:umInI:u:-undMu:udule j Browse, .. | T, |

Mamespace: Ihttp:,I',I'FTPCustDmIanundMDdule ¥ Default

Falder: I Browse, ., |
Marme: | CuskomFS I

__j. Click Finish
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You are now done with configuring the Function Selector, CustomFS and, in that process, configured a
data handler, CustomDH inside the function selector configuration wizard. You are back to the
External Service wizard and the configured function selector, CustomFS is displayed for Function
Selector Configuration field:

Function selectar: ILIse a function seleckar n:n:nnFiguratin:nn"—j

Function seleckor configuration;: | CuskomFS fff—— Seleck,,,

Data binding configuration:

15. You can define data binding in two places - service level (current screen of External Service wizard)
or later at the method level (Operations screen of the External Service wizard). In this lab, you will
define data binding at the service level (from this screen)

__a. From the dropdown menu next to Data format options, select ‘Use a data binding
configuration for all operations’

[rata Format opkions: i lse a data Format configuration For all operations
Drata Format: Mot defined Select... |

___b. Click Select... next to Data format. A Binding Resource Configuration window is opened

___C. Select the radio button for ‘Use existing data format transformation from the list’ and then
select FTPFileBaseDataBinding

{* Use existing data format transformation from the list

FileBaseDataBinding

___d. Click Next
___e. Select the UTF8XMLDataHandler for data handler:
1) Click Select next to ‘Configured data handler’

2) From the Binding Resource Configuration window, select XML > UTF8XMLDataHandler
listed under ‘Use existing data format transformation from the list’

__f. Click Finish

__ 0. Back to Data Transformation Properties and the selected data handler ‘UTF8XMLDataHandler’
is displayed here:
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= Data Binding Configuration

Data Transformation Froperties

Specify the properties for the data transformation, |

Select DataBinding if wou wank to use a data binding developed faor earlier versions of the

adapker,

Binding tvpe: CrakaHandler hj

Configured data handler: UTFaXMLDataHandler ] “eert,

Configured data binding: kot defined Seleck, ., |
___h. Click Next

___i. Note that the selected module is FTPCustominboundModule

1) For the Name, enter CustomDB

Module: IFTPCustDmInbnundMDdule j Browse, ., |

Mamespace: Ihttp:,I',I'FTPCustn:nmInhn:-undMn:-dule v Default
Folder: I Browse, ., |
Mame: | CUskamDE af—

2) Click Finish

___j- Now the CustomDB should be displayed for Data binding configuration

Service properties

Function selector options: ILIse a function seleckor configuration j

Funiction selector: # CustomFs Select. .. |
Drata Farmat opkions; ILIse a data farmat configuration Faor all operations "—j

Daka Format: # CustomDB e Sleit,

16. Check the box next to Change logging properties for wizard to view the output location of the log
file and the logging level and click Next
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Define emitCustomerFile operation:
_____17. From the Operations screen, click Add...
Add Operation window is opened
___a. Select User defined type for the Data type and click Next

x

Operation
Select the operation kind.

Operation properties

Data type for the operation: M= ==y

(7) = Back I Mext = I Einiish Cancel

You are now back to Operation window and because you chose the User defined data type, the Input
type is blank

___b. For Operation name, enter emitCustomerFile
__c. Define Input type:
1) Click New... next to Input type to open a New Business Object window

2) From this window, ensure that the Module selected is FTPCustominboundModule and
click Next

3) Click Browse... next to Data type

4) From the Data Type Selection window, select Customer under Matching data types:
#4= Data Type Selection I =]
Filter by tvpe, namespace, or file (¥ = any character, * = any String):

Makching data bypes:

]
=

I_ |
Crder

5) Click OK

6) From the Type Wizard, check the box next to Generate business graph for each
business object

7) Do not check the box for ‘Generate retrieve container to retrieve multiple business
objects’
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Note: The ‘Generate retrieve container to retrieve multiple business objects’ is used only during outbound
retrieve operation.

4= New Business Object Hi=]
Business Object Properties P
Specify the properties for the new business object, H'/J_'
s
Data kype: # | Cuskomer {htkp:f e ibm, comyxmins/prodfwebsphereMie= Browse,. | Mew. . |

[|7 isenerate business graph For each business -:ul:ujectél

Mamespace for generated business graph and container objeck,

Business object namespace; | hikkps § e, b, com)=mins fprod fwebspherei2ca)flatFile

[™ Generate retrisve container ko retrieve mulkiple business objects  slE——

8) Click Finish

___d. The Input Type in Add Operation window is populated with CustomerWrapperBG, because you
have selected to have business graph (BG) generated

__e. For Data format options, accept the default selection Use data format configuration
‘CustomDB’ from the dropdown list

#4= Add Dperation [_|O]
Operation

Specify the properties for the operation bo add,

\;\J .

Operation name: * I emitZuskomerFile I

Specify the operation input

Input kype: * ICustDmerWrapperBG {hkkp: e ibm. comyxmins)proc «m—'- Mew, .,

[rata Format options: ILIse data Farmat configuration "CustomDE' "_j

[ata Format: Mot defined Seleck, ., |

___f. Click Finish. The defined operation, emitCustomerFile is populated in the Operations list.

i+ External Service [_ O]
Operations F_;;q
Add, edit or remove operations that will be used by the adapter to access native Functions, _E!E'b

Oper ations:
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Define emitOrderFile operation:
___18. From the Operations screen, click Add...
Add Operation window is opened
___a. Select User defined type for the Data type and click Next

You are back to Operation window and because you chose the User defined data type, the Input type
is blank.

___b. For Operation name, enter emitOrderFile

__c. Define Input type:
1) Click New... next to Data type to open a Type Wizard window
2) From the next screen, ensure that FTPCustominboundModule is selected and click Next
3) Click Browse... next to Data type

4) From the Data Type Selection window, select Order under Matching data types:

#= Data Type Selection [_ O]

Filter by tvpe, namespace, or file {7 = anw character, * = any String):

Matching data bypes:

[ Customer
[ Cusktomer'Wrapper
CustumerWrapperBG

‘Order

5) Click OK
6) Do not check the box next to Generate business graph for each business object

7) Do not check the box for ‘Generate retrieve container to retrieve multiple business
objects’

Note: From V6.1, the generation of business graph is optional and you can leave this option unchecked.
As a result, Adapter will not generate the BG for Order business object and you can confirm this bye
reviewing the generated data types from the business integration view of your WebSphere Integration
Developer. The ‘Generate retrieve container to retrieve multiple business objects’ is used only during
outbound retrieve operation.

Daka tvpe: # | Order {hkp: /v, ibrn, comyzmins prod/websphere)jml=— Erowse... | MNew...
@Generate business graph for each business object

Mamespace for generated business graph and container object.

Business object namespace: | Rikkpe v, ibm. carmmins prod fvwebspher e fi2c a Flatfile

@enerate retrieve container ba retrigve mulkiple business objects.
8) Click Finish
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___d. The Input Type in Add Operation window is populated with OrderWrapper, because you have
not selected to have business graph (BG) generated

___e. For Data format options, accept the default selection Use data format configuration
‘CustomDB’ from the dropdown list

Cperakion name: # IemitOrderFiIe I

Specify the operation inpuk

Input bype: # |Or|:|er'-.-'-.-'rapper {http:,l',l'www.ibm.cnm!xmlnsiprud!webw

Data Farmat options: IUse data Farmat configuration "CuskamDE! "—j

[ata Format; Mot defined Select,,, |

___f. Click Finish

___g. The defined operation; emitOrderFile is populated in the Operations list

Operations:

emitcustomerFile ({http: {fwww . ibm. comfxmins fprod/websphere fj 2cafftpfcustomerwrapperbg}CustomerWrapperBG) @ void
=W emitCrderFile ({http:fjwww.ibm.com/xmins/prodfwebsphere fj2ca fip forderwrapper}OrderiWrapper) : void

___h. Click Next
19. From the Generate Artifacts screen, enter these:

___a. For Name, enter FTPCustomInboundiInterface

Propetties for service

Madile; IFTPCustDmIanundMDdule j TEw, ., |

Mamespace; Ihttp:,I',I'FTF'Custu:umInI:u:uundMu:udule,l'FTF'Custu:umInI:ucuunu:IInterFace

¥ Use default namespace

rame: *'"l FTPCustomInboundInterface|

Description: |

___b. Click Finish

20. You will now see a new export component, FTPCustominboundinterface in the assembly diagram
of FTPCustomInboundModule

'?8.' *ETPCustamInboundModule - Assembly Diagram &5
<] = Palette

IE ) =) A, 1)

L ] -
(= Favarites ﬂ:ﬂ ﬁ-p FTPiCustomInboundInterface
L]

___a. Save (Ctrl+S) your changes to the assembly diagram
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__21. Review the generated Native method bindings for the defined operations:
___a. Ensure that the FTPCustomInboundinterface is selected from the Assembly diagram

___b. From the bottom panel, select Properties > Binding > Method bindings

Note: The Native method name should be ‘emit’ added as a prefix to the business object name, that is.,
Native method = emit + Business Object name. In this case, for the processed business object
Customer, the Native method is emitCustomer and for Order, it is emitOrder.

___¢. From the Bound Methods list, click emitCustomerFile and you should see emitCustomer as the
Native method

__d. Now, click emitOrderFile from Bound Methods and you should see emitOrder as the Native
method

22. Review the FTPCustominboundModule: The generated Data Types, Interface, and the Function
selector (CustomFS) Data binding (CustomDB), and Data handler (UTF8XMLDataHandler) under
Configured Resources can be found inside FTPCustominboundModule

El:g FTPCustormInboundrodule
Elfsj Aszsembly Diagram
- ﬁ%p FTPCustomInboundinterface
----- & Dependencies
----- o= Integration Logic
I';'I---ié Daba Types

If] Cuskarmer
{71 Customeriirapper
- Customer'wrapperBG
(2] Order
LA7] OrderWrapper
I';'I---'i' Interfaces
o @IFTPCustnmInhDundInterFaceI
..... & Mapping
=N = Binding Resources
Ellcb Commononfiograkions
| & UTFEKMLDataHandler
I 2. CustomDE
48| CuskomFs

You can open each of these generated artifacts and business objects and review the properties inside.
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Review the created methods inside the interface:

___a. From the Business Integration view, expand FTPCustominboundModule > Interfaces and then
double-click FTPCustomInboundIinterface to open it

(D Frecustominboundinterace 37 -

Interface EE
Configuration
Marmne FTPCustomInboundInterface Refactor name

Mamespace | htkp:/fFTPCustomInboundrodule!FTPCustomInboundInterface
Binding Style | dacurent literal wrapped

Refactor namespace
Change binding stvle to docurment liceral non-wrapped  More. ..

=Dperations #HEDB | P I e |
COperations and their parameters
| Marne | Tvpe
L4 %ég. emitCustomerFile
[ Inputs | emitCustomerFileInput | CuskamerwrapperBG
L4 %ég. emitOrderFile
L Inputs | emitOrderFileInput | Orderit'rapper
__b. Close the interface, FTPCustomInboundinterface
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3.2. Add Java component

In this part of the lab, you will add a Java component to the module and then wire the export to the added
component. Then you will add the custom Java code to the added module.

1. Open the assembly diagram for FTPCustomInboundModule, if it is already not open

___a. From the business integration view, expand FTPCustominboundModule and double click
Assembly diagram

2. Drop a Java component to onto the assembly diagram
___a. From the Palette, click Components to expand it

___b. Click Java and then click the empty space of FTPCustomInboundModule assembly diagram.
This will place a new component, Componentl on the assembly diagram.

3.  Wire the FTPCustominboundinterface to the Componentl

__a. Select the wire (CL:') icon from the Palette
___b. Click FTPCustomInboundinterface and then click Componentl to wire them together

___C. Select OK for the Add Wire pop-up window. Your assembly diagram for
FTPCustomInboundModule will look like this:

GSJ F%p FTPCustomInboundinterface @ L—".ﬂ Component 1
f .-

___d. From the top of the Palette, click the Selection Tool icon ( [%) to get back to the normal cursor
mode

4. Generate Java Implementation
___a. Right-click Componentl and select Generate Implementation from the pop-up menu
__b. On the Generate Implementation panel, select default package, and click OK

___¢. Componentlimpl.java is opened in Assembly editor. Scroll down to the method
emitCustomerFile that needs to be implemented and add this code under that method:

System.out .println(rxxssxxsixxt ENDPOINT emitCustomer s xridktidkitirty;
DataObject wrapper =
emitCustomerFilelnput.getDataObject(*"CustomerWrapper™);
String filename = wrapper.getString(''Filename™);
System.out .printIn(""FILENAME : "+Ffilename);

DataObject customer = wrapper.getDataObject(*'Content™);
String name = customer.getString(‘'customerName™);
System.out .printIn("’"NAME----- > "+name);

String address = customer.getString("'Address');
System.out .printIn(""ADDRESS--> "'+address);

String city = customer.getString('City™);

System.out .printIn("CITY-—--—- > "+city);

String state = customer.getString(‘'State');

System.out .printIn(""STATE----> "'+state);
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Note: The code is also available at <FTPFILES>\CustomerJavaCode.txt for your convenience

___d. Scroll down to the method emitOrderFile and add this code:

System.out .println('xxx*sxrxxxttENDPOINT emi tOrder** irrtiiiiry -
System.out .printIn("'FILENAME :
"+emitOrderFilelnput.getString("'Filename™));

DataObject order = emitOrderFilelnput.getDataObject(*'Content™);
String OrderNumber = order.getString(''OrderNumber™);

System.out .printIn("'ORDER NUMBER----- > ""+0rderNumber);

String OrderType = order.getString("'OrderType'™);

System.out .printIn("’'ORDER TYPE--> "+OrderType);

String Quantity = order.getString('Quantity');

System.out _printIn(""QUANTITY----- > "+Quantity);

String Price = order.getString("'Price™);

System.out .printIn(""PRICE----> "+Price);

Note: The code is also available at <FTPFILES>\OrderJavaCode.txt for your convenience

___e. Save (Ctrl + S) and close Componentlimpl.java

5. Save (Ctrl + S) and close Assembly diagram: FTPCustominboundModule
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3.3. Test non pass through scenario

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the non pass through Scenario with input file having a single business
object.

1. Add the project to the WebSphere Test Environment server

a. Right-click WebSphere Process Server v7.0 under the Servers view and select Add and
remove projects... from the pop-up menu

b. From the Add and Remove Projects window, select FTPCustominboundModuleApp under
Available projects panel and click Add >

c. You will now see the FTPCustominboundModuleApp added to the Configured projects

d. Click Finish and wait until the project is being published onto the server. The server is started in
Debug mode if it is not already started before

2. Putthe input files in the event directory

Note: For your convenience, the test files SingleCustomerBO.xml, SingleOrderBO.xml are placed in
<FTPFILES>.

__a. On the machine where the FTP Server is running, put SingleCustomerBO.xml file in the
EventDir. The adapter will poll the copied file from the event directory and will transfer it to the
archive directory

___b. Because you have placed a file that contains a BO of type Customer, it will pass through the
emitCustomerFile method and you should see this message in your Server Logs view (or
SystemOut.log):

Twpe ~  Time Thread ID Zonkents
B B Logmessage Aebtkkeksk kR ENDPOIMT emibCustopneptekttttbtabatao:
O = Log message Dec 16, 2003 16:10:20,343  0O0000SEF FILEMAME : SingleCustomerBOC, xml
O = Log message Dec 16, 2008 16:10:20,343  00000SkHF MAME----- = IBM
O = Log message Dec 16, 20058 16:10:20,343  00000ShHF ADDRESS--= 11501 Burnet Fd
O = Log message Dec 16, 2003 16:10:20,343  0O0000SEF ZITY-----= Austin
O = Log message Dec 16, 2008 16:10:20,343  0000O0SEHF STATE----= Tx

___¢. On the machine where the FTP Server is running, put SingleOrderBO.xml file in the EventDir.
The adapter will poll the copied file from the event directory and will transfer it to the archive
directory
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___d. Because you have placed a file that contains a BO of type Order, it will pass through the
emitOrderFile method and you should see this message in your Server Logs view (or
SystemOut.log):

Tvpe I «  Time I Thread ID I Conkents
O [= Log message Dec 16, 2003 16:10:20,343  00000SkF AR E N DPOIMT emitCushomer stk
O = Log message Dec 16, 2003 16:10:20,343  00000SkF FILEMAME : SingleCustomerBC, xml
D = Log message Dec 16, 2008 16:10:20,343 00000SkF MAME----- = IBM
D = Log message Dec 16, 2005 16:10:20,343 000005k0F ADDRESS--> 11501 Burnet Rd
D = Log message Dec 16, 2005 16:10:20,343 000005k0F CITY----- = Buaskin
D = Log message Dec 16, 2005 16:10:20,343 00000SkF STATE----=> T

B B Log message Atk E NDPOINT emitQrdey stttk
O [= Log message Dec 16, 2003 16:10:50,073  00000SEF FILEMAME : SingleCrderBd, xml

D = Log message Dec 16, 2005 16:10:50,075 00000skF OR.DER MUMEER.----- > BBC125345

D = Log message Dec 16, 2005 16:10:50,075 000005k0F QORDER TYPE--= BULE

O = Log message Dec 16, 2008 16:10:50.075  00000SKF CUAMTITY - 500

D = Log message Dec 16, 2008 16:10:50,075 0oo0oskF PRICE----> 26,59

3. You can also verify the results by reviewing the archive directory

___a. Check the ArchiveDir of your FTP server which should contain the same file name appended
with year, month, date, system time, and processed

___b. Check the <LOCAL_ARCHIVE_DIR> subdirectory which should contain two archives of the
event files, with the same file name appended with year, month, date, system time, and success

4. Restore the Sever Configuration

___a. Right-click WebSphere Process Server v7.0 under the Servers view and select Add and
remove projects... from the pop-up menu

__b. Select FTPCustominboundModuleApp under Configured projects and click < Remove

___c. Click Finish after you see the application moved to Available projects. Wait until the application
is being unpublished
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3.4. Test non pass through scenario with SplitByDelimiter

In this last part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the non pass through Scenario with input file having multiple business
objects separated by a delimiter.

1. Configure/change the adapter properties from the Properties view:
___a. Change to Business Integration perspective if you are in a different perspective
1) Select Window > Open Perspective > Other...
2) From the Select Perspective window, select Business Integration (default) and click OK

b. Expand FTPCustominboundModule and double-click FTPCustominboundModule to open it
in Assembly Editor

c. Click FTPCustominboundinterface from the Assembly Editor and select Properties tab from
the bottom

d. Select Binding under Properties and select End-point configuration under Binding itself and
then select the Connection

___e. Now click Advanced>> button at the bottom
___f. You can see all the properties that were given during the external service wizard
___@g. Scroll down to Additional configuration:

1) Select the box for ‘Split file content based on the size (bytes) or delimiter’

2) Split function class name: com.ibm.j2ca.utils.filesplit.SplitByDelimiter (you can also
Browse... and select this class name)
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3) Specify criteria to split file content: #####

| Additional configuration |

Ratiave fas with v paffern: B

Sort avent Flas: na sort [~]

Enabia remote verFiation

Encoding wsed by FTP sarvar:
Fie confent encoding:
FIP sarver connection moce.: ackive E

e transfer frpa: binary [=]

Number of Alas fo gat af a time. 10

Ambear of poff parings batmiaan Ehe connioads: 5

FPaputate e full quatified caze name of fhe cusfom parser Fhal is wrad fo parra the e - oufout. Thie is wead onde whan ghe I - oufout daviater fram
standard oufout,

Cusfom parser class name. Erowse. ..
[ Fasr oniv fie name and directory, nof the content
O mctute business ofject delmitar i the e contant

Sndt fife contant hazed on tha sire (hytas) or dalmitar, ]

SpliE Function ofass name. com.ibrn, j2ca,utils, Filesplit, SplitByDelimiter Browse. .,
SpeciFy crfara fo 5oiF fie confent.

Run FTP sovipt file before downinading fAilas: | Browse. ,,
Run FTP sonpé file affer domnipading fas, Browse. .,

nh |

___h. Click Assembly diagram (or any where else so that the save button is enabled) and then save
(Ctrl +S) your changes

2. Repeat Step 1 of part 3.3 to add the saved project FTPCustominboundModuleApp to the server

3. Test the input file CustomerSplitByDelimiter.xml

Note: For your convenience, a test file CustomerSplitByDelimiter.xml is placed in <FTPFILES>. The file
contains two Customer Business Objects separated by the delimiter #####.

__a. On the machine where the FTP Server is running, put CustomerSplitByDelimiter.xml file in the
EventDir. The adapter will poll the copied file from the event directory and will transfer it to the
archive directory

__b. Because you have placed a file that contains BOs of type Customer, it will pass through the
emitCustomerFile method and you should see this message in your Server Logs view (or
SystemOut.log):
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Note: You will see the successful event delivery message twice as there were two Business Objects
present in the event file separated by the delimiter #####.

Tvpe ~  Time Thread ID Conkents
B B Logmessage Dec 16, i 16:17:21.575 Akttt ENDPOINT emitCushomeptettstbrtbbbtaababer
D = Log message Dec 16, 2005 16:17:2 0oo0oo0s0 FILEMAME : CuskomerSplitByDelimiter sl
D = Log message Dec 16, 2005 16:17:21.575 0oo0oo0s0 MAME----- = Michele
D = Log message Dec 16, 2005 16:17:21.575 0oo0oo0s0 ADDRESS--2 Da Vinc Ave,
D = Log message Dec 16, 2005 16:17:21.575 ooaooos0 CITY === = Mewyork,
D = Log message Dec 16, 2005 16:17:21.575 0oo0oo0s0 STATE----= MY
O [ Log message Dec 16, 2008 16:17:21,593  000006F Akckchksk R E N DPOINT emibiZushomer¥eksdsekokiok
O [5) Log message Dec 16, 2005 16:17:21.593 | 000006&F: FILEMAME : CuskomerSplitByDelimiter sl
O [ Log message Dec 16, 20058 16:17:21,593  000006&Fe MAME----- = Michele
D = Log message Dec 16, 2005 16:17:21.593 0000aFe ADDRESS--2 Da Vinc Ave,
D = Log message Dec 16, 2003 16:17:21.593 Qoo00&fe CITY----- = Mewyark,
D = Log message Dec 16, 2005 16:17:21.593 0000aFe STATE----= MY

1) Check your <ARCHIVE_DIR> which should contain an archive of the event file, with the
same file name appended with year, month, date, system time, and success
m SingleCustomerB0, xml, 2007_10_10_22 00_43_212.success
m SingleQrderB0. xml, 2007_10_10_22 _02_29_185,s5uccess
CustomerSplitByDelimiter, xml, 2007_10_10_22 15 53 762.5uccess

4. Test the input file: OrderSplitByDelimiter.xml

Note: For your convenience, the test file OrderSplitByDelimiter.xml is placed in <LAB_FILES>\FTPfiles.
The file contains two Order Business Objects separated by the delimiter ####.

___a. On the machine where the FTP Server is running, put OrderSplitByDelimiter.xml file in the
EventDir. The adapter will poll the copied file from the event directory and will transfer it to the
archive directory

___b. Because you have placed a file that contains BOs of type Order, it will pass through the
emitOrderFile method and you should see this message in your Server Logs view (or
SystemOut.log):
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Note: You will see the successful event delivery message twice as there were two Business Objects

present in the event file separated by the delimiter #####.

& Time

Thread ID

Conkents

B B Logmessage
O = Log message
0= Log message
O Loa message
O = Loa message
O = Log message
O = Log message
O = Logmessage
O = Logmessage
O = Log message
0= Log message
O Log message

Dec 16,

05 16:19:11.
Dec 16, 2005 16:19:11,
Dec 16, 2008 16:19:11,
Dec 16, 2005 16:19:11,
Dec 16, 2005 16:19:11,
Dec 16, 2005 16:19:11,
Dec 16, 2005 16:19:11,
Dec 16, 2005 16:19:11,
Dec 16, 2005 16:19:11,
Dec 16, 2005 16:19:11,
Dec 16, 2008 16:19:11,
Dec 16, 2005 16:19:11,

140
140
140
140
140
171
171
171
171
171
171

Q00006 e
00000&FE
Q0000&Fe
Q0000&Fe
00000&Fe
Qo000
Qaoooos0
Qaoooos0
ujula]nuinl=ln]
Qoooo030
Qaoooos0

FHARERERDPOINT emibOrder**+:
FILEMAME : OrderSplitByDelimiter . xml
QRDER. MUMEER.----- = BEC125345
ORDER. TYPE--= BULK
QUAMNTITY----- =500
PRICE----2= 26,59
FILEMAME @ OrdersplitByDelimiter il
CORDER. MUMBER----- = RBC12345
ORDER TYPE--= BULE
QUANTITY----- =500
PRICE----7 26,59

1) Check your <ARCHIVE_DIR> which should contain an archive of the event file, with the
same file name appended with year, month, date, system time, and success

2010 April, 09

Mame

m SingleCustomerBO, xml, 2007_10_10_22_00_43_212.success
m SingleCrderBO,xml, 2007_10_10_22 02_29_135.success
m CustomerSplitByDelimiter. xml, 2007 _10_10_22 15 53 762.success

IBM WebSphere Adapter 7.0 — Lab exercise

OrderSplitByDelimiter. xml, 2007_10_10_22 23 13 564.success

5. Repeat Step 4 of part 3.3 to restore the sever configuration
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Part 4: Use default function selector and data binding

This part of the lab will show you how to use the default use the default function selector and data binding
options from the External Service wizard and generate other required artifacts.

When you use the default function selector, you cannot define the rules as you did in Part 2 and hence
there will only be one method that handles all types of files.

When you use the default data binding, you cannot have multiple data types as in Part 3 and each data
type is handled by different method. Instead, there will only be one method and one data type.

After running the External Service wizard, you will add the required Java component with implementation
and then will continue to test the adapter.
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4.1. Configure inbound using default function selector and data
binding

In this part of the lab you will use the default function selector and data binding options from the External
Service wizard and generate other required artifacts to test the inbound scenario.

1. Create FTPDefaultsinboundModule

___a. From the Business Integration window, right-click and select New > Module
___b. From the New Module window, enter FTPDefaultsinboundModule for the Module Name
___c. Ensure that the box next to Open module assembly diagram is checked and then click Finish

You will now see a new module, FTPDefaultsinboundModule, created from your Business Integration
window

2. To start External Service from the Palette:

___a. From the Palette on the left side of Assembly Diagram, click Inbound Adapters:

___b. Under Inbound Adapters, click the FTP and then click the empty canvas of the assembly
diagram. The New FTP Service wizard is opened

3. From the New External Service window, expand Adapters > FTP and select Advanced: Create a

FTP service using the complete wizard

¥ New External Service M=l
Select the Service Type or Reqgistry -
Select the bype of service to create or reqgistry to browse, { 3

Filter: Jbvpe filter bt

fvvailable bypes;
= @;‘ Adapters
=-fte FTP
inva ocvanced: Create a FTP service using the complete wizard
E‘p" Simple: Create an inbound FTP service ko read From a remoke File

Description:

Creates a service that reads fram ar wrikes ba a file on a remaote File syskem using the WebSphere® -
Adapter for File Transfer Protocol (FTP), You can create inkegrated processes ko access files managed by

the FTP server without special coding. During outbound processing, the adapter receives a request From

the module in the Form of a business object and then the adapter processes the request and returns the
result when applicable, in a business object, During inbound processing, the adapter polls a file sywskem
associated with a FTP server for events at specified intervals, When the adapter detects an event, it
requests a copy of the file, converts the file into a business object, and sends it to the consuming service,

___a. Click Next

Note: You can also start the External Service from the File menu option:
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From the main menu, select File > New > External Service. This opens an External Service wizard that
helps you obtain a service which establishes connectivity with other systems. Select Adapters > Flat File
and click Next.

4. Onthe Select an Adapter screen, expand IBM WebSphere Adapter for FTP (IBM : 7.0.0.0_IFO01)
and select CWYFT_FTPFile

___a. Click Next

Note: If you are using the File menu option to start the External Service wizard, you are asked to select
the Processing Direction at this point. Select the radio button next to Inbound and click Next to proceed
to the next step.

5. Service Configuration Properties:

___a. Deploy connector project: ensure that the default option With module for use by single
application is selected

___b. Enter these for FTP system connection information:

1) Host name: <FTP_Machine_Name> (or IP Address of the machine that has FTP Server),
for Ex: wsbetal81.austin.ibm.com

2) Remote directory: full path of the EventDir created in on the machine where FTP
server is existing (for Ex: /nome/wsbeta/EventDir)

Note: This is the directory from where adapter gets the event files.

3) Local directory: <LOCAL_EVENT_DIR>
4) Protocol: FTP — file transfer protocol (default)

5) Port number: 21 (default)

Deploy connectar projeck: I'u'u'ith module For use by single applicatinn-(—j

Conneckion setkings: ILlse properties below j

Conneckion propetkies

FTP system connection information

Host name: # | wshetal49, austin,ibm.com |

Remote direckory:* [,l'ru:u:ut,l'Deskl:u:up,l'EventDirI

Local directary: = |C:'I,Lal:ufiles?EI'I,FTF‘InI:u:uunu:I'l,Lu:u:aIEventDir Browse, .,
Prokocal; IFTF‘ (File Transfer Protocol) "—j
Park number: | 21—

___c. Click Advanced >> to see the hidden advanced properties that can be configured:

You can click each of the configurations and review the options available under it. For this part of the lab,
you will need only some of these properties.
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___d. Event persistence configuration: In this part of the lab, you will not use any JNDI instead use
adapter’s in-memory representation of event table to store all the necessary information

Note: The Event recovery data source (JNDI) name is not mandatory from V6.1. Now, the adapter can
use in-memory representation of event table to store all the necessary information. Adapter uses this
feature when event database information is not configured during inbound event polling. This feature will
not support the capability of handling “Ensure once-only event delivery”.

__e. FTP archiving configuration:
1) Local Archive directory: click Browse... and select <LOCAL_ARCHIVE_DIR>

2) Remote archive directory: full path of the ArchiveDir created in on the machine where
FTP server is existing (for Ex: /Thome/wsbeta/ArchiveDir)

|~ FTP archiving configuration

To archive processed inbound event files on the local syskem, specify a local archive directory, To
archive files on the remate system For the inbound event Files downloaded ta the lacal syskem,
specify a remaote archive directory,

Local archive directory: | i Labfiles70VFTPINboundiLocalarchiveDir (_[M

File extension Far local archive: | ariginal

Success file extension faor local archive: | SUCCESS

Failure file extension For lacal archive: I Fail

Remoke archive directory: I {runt{DesktnELﬁ.rchiveDirl

File extension Far remote archive: I

6. For this lab, you are going to use the security properties from the activation specification.
___a. Select the check box next to Using security properties from the activation specification
___b. User name: username using which you connect to your FTP server (for Ex: root)

__c. Password: password for the user to connect to your FTP server

Service properties
How do wou want ko specify the security credentials?
™ Using an existing 1445 alias {recommended)

& Jawva Authentication and| suthorization Services (1&45) alias is the preferred method.

12T authentication data entey |

[F Lsing security propetties fram the ackivation speciFicatiDnI

The properties will be stored as plain kext; no encryption is used,

Ilser name: e l r':":'tl
Passwiord: # l ********I

i Other

Ise if nm securiby is required ar wil be handled by the EIS system, or the RAR will be deplayed on
the server and securiby will be specified by the properties in the JNET loakup name,
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7. Under Service properties, for Function selector options, select Use default function selector
‘FilenameFunctionSelector’ from the drop down list

8. For Data format options, select Use default data binding ‘FTPFileBaseDataBinding’ for all
operations from the drop down list

Function selector opkions; ILIse default funckion seleckor 'FilenameFunctionSelectar’ -(—j

Function seleckar: Mot defined Select, .,

Drata Format options: ILIse defaulk data Format 'FTPFileBasebatabinding' for all operations +j

[ata Farmats Mot defined Select, .,

9. Check the box next to Change logging properties for wizard to view the output location of the log
file and the logging level and click Next

Define emitFTPFileBG operation:
10. From the Operations screen, click Add...

___a. Add Operation window is opened. Select Generic FTP business object with business graph
for the Data type and click Next

Operation properties

The data type for the operation input: e S e ) e A A N e

You are back to Operation window and because you have chosen the data type with business graph,
the Input type is populated as FTPFileBG.

11. For Operation name, enter any name, for Ex: emitFTPFileBG

12. Accept the default selection, Use suggested data format ‘FTPFileBaseDataBinding’, for Data
format options

Ciperakion name: * IemitFTF‘FiIEBG I

Specify the operatian inpuk

Input Evpe: |FTF'FiIeBG {hiktpe  feaen. b, corngxminsfprod fwebsphere iz Browse. .. | M., |

Draka Format options: ILIse suggested data format 'FTPFiIeBaseDataBinding'-‘—j

[ata Formats Mot defined Seleck, ., |

___a. Click Finish. The defined operation, emitFTPFileBG, is populated under Operations list

Operations:

------ emitFTPFileBa ({htkp: [ fwnsn, ibm, comfmins prodwebsphereizca fip/frpfilebo FETPFileBE) @ void

___b. Click Next from Operations screen
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13. From Generate Service screen, accept the default value, FTPExport, for Name

Properties for service

MMadule; IFTPDeFauItsIanundMDdule j eV, . |

Mamespace; |http:,l',l'FTF'DeFauItsInI:nc'undM-:nduIe,l'FTPExpn:nrt

v Use default namespace

Mame: #* I FTPExport self—

Description: | |

___a. Click Finish

14. The Assembly diagram for FTPDefaultsinboundModule is opened with an Export component,
FTPExport

] *FTPDefaultsInboundModule - Assembly Diagram &7
<] . Palette

]E (=17, )
@ 15'%9 FTPExpork

) L= Favarites.

15. Save (Ctrl + S) changes to your assembly diagram
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4.2. Add Java component

In this part of the lab, you will add a Java component and then wire the component to the existing Export
interface. The Java component is your endpoint.
1. Open the assembly diagram for FTPDefaultsinboundModule (if it is already not open)

___a. From the business integration view, expand FTPDefaultsinboundModule and double click
Assembly diagram

2. Drop a Java component to onto the assembly diagram
___a. From the Palette, click Components to expand it

___b. Click Java and then click the empty space of FTPDefaultsinboundModule assembly diagram.
This will place a new component, Componentl on the assembly diagram.

3. Wire the FTPExport to the Componentl

__a. Select the wire (CL:') icon from the Palette
___b. Click FTPExport and then click Componentl to wire them together

___C. Select OK for the Add Wire pop-up window:

___d. From the top of the Palette, click the Selection Tool icon ( [‘}) to get back to the normal cursor
mode

___e. Right-click the empty space of the Assembly diagram and select Arrange Contents
Automatically from the pop-up menu. Your assembly diagram for FTPDefaultsinboundModule
will look like this:

GSJ F%p FTPExport @ L—".E Camponent1
f .-

___f. Right-click Componentl and select Generate Implementation from the pop-up menu
___g- On the Generate Implementation panel, select default package, and click OK

___h. Componentlimpl.java is opened in Assembly editor. Scroll down to the method
emitFTPFileBG that needs to be implemented and add this code under that method:

System.out .printIn(‘"***********Reached Endpointx****xkxtixiy -
___i. Save (Ctrl + S) and close Componentlimpl.java

___j. Save (Ctrl + S) and close Assembly diagram: FTPDefaultsinboundModule
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4.3. Test defaults scenario

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the pass through scenario.

1. Add the project to the WebSphere Test Environment server

a. Right-click WebSphere Process Server v7.0 under the Servers view and select Add and
remove projects... from the pop-up menu

b. From the Add and Remove Projects window, select FTPDefaultsinboundModuleApp under
Available projects panel and click Add >

c. You will now see the FTPDefaultsinboundModuleApp added to the Configured projects

d. Click Finish and wait until the project is being published onto the server. The server is started in
Debug mode if it is not already started before

2. Test the application by providing three different input files:

Note: For your convenience, three test files, sample.txt, sample.txtl, sample.txt2 are placed in
<FTPFILES>.

___a. On the machine where the FTP Server is running, put sample.txt (or any of the three sample
files) file in the EventDir. The adapter will poll the copied file from the event directory and will
transfer it to the archive directory

__b. No matter what type of file you put in Event directory, it will pass through the only existing
method, emitFTPFileBG, and you should see this message in your Server Logs view (or
SystemOut.log):

O = Log message Dec 16, 2008 17:13:57,934 00000726 WaYRO0ZZ11 Application started; FTPDefaultsInboundioduy, .

B B Logmessage Dec 16, 2008 17:14:28.906 kAR g ached Endpoin R

Verify the results:

___ . Check the <LOCAL_EVENT_DIR> on your local machine. The file is quickly moved from this
directory to the local archive directory

___d. Check the ArchiveDir of your FTP server which should contain the same file name appended
with year, month, date, system time, and processed as you have given

___e. Check the <LOCAL_ARCHIVE_DIR> subdirectory which should contain an archive of the event
file, with the same file name appended with year, month, date, system time, and success

3. Restore the Sever Configuration

__a. Right-click WebSphere Process Server v7.0 under the Servers view and select Add and
remove projects... from the pop-up menu

___b. Select FTPDefaultsinboundModuleApp under Configured projects and click < Remove

__c. Click Finish after you see the application moved to Available projects. Wait until the application
is being unpublished
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Part 5: Use ‘Create a service from a typical pattern’

In this part of the lab you will use the typical pattern option from the External Service wizard to create and
configure the Function Selector, Data Binding and other required artifacts to test the inbound scenario.

Based on your selection, the Binding resources (data binding and function selector) are created which you
will review later in this part.

After running the External Service wizard, you will continue to add the Java component with
implementation and then test the adapter.
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5.1. Configure inbound using ‘Create a service from a pattern
(typical)’ option

In this part of the lab you will use the typical pattern from the External Service feature to create and
configure the Function Selector

1. Create the module: FTPTypicallnboundModule
___a. From the Business Integration window, right-click and select New > Module
___b. From the New Module window, enter FTPTypicallnboundModule for the Module Name
___c. Ensure that the box next to Open module assembly diagram is checked and then click Finish

You will now see a new module, FTPTypicallnboundModule, created from your Business Integration
window and the Assembly diagram for the same module is opened in the Assembly Editor.

2. Import required business objects

New in V7.0: Wrapper business objects for the business objects containing global elements are supported in
this version. So, you can now pass the protocol specific information as part of each request.

___a. Expand FTPTypicallnboundModule (if not already expanded), right-click Data Types and select
Import... from the pop-up menu

___b. From the Import window, expand General and select File System and then click Next
___c. Enter From directory

1) Click Browse... next to From directory

2) From the Import from directory window, select <FTPFILES > and click OK

Now, you will see FTPFiles folder added on the left side, and all the xsds and files under that folder on
the right side.

___d. Select the box next to Customer.xsd
___e. Ensure that the FTPTypicallnboundModule is selected for Into folder
__f. Click Finish from the Import window
The Business Integration window is updated with the imported business objects.
3. Review imported business object:

___a. Expand FTPTypicallnboundModule > Data Types and you will now see a new data type
Customer and Order under it.
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___b. Double-click Customer review the fields inside the object:
[ Custamer

= = Click to Filker, .. =

[&] CustomerMame skring

(e Address skring
[8] Cit skring
[e] Skate skring

___c. After reviewing, close the Customer business object from the Assembly editor
4. To start External Service from the Palette:
___a. From the Palette on the left side of Assembly Diagram, click Inbound Adapters:

5. Under Inbound Adapters, click the FTP and then click the empty canvas of the assembly diagram.
The New FTP Service wizard is opened

6. From the New External Service window, expand Adapters > FTP and select Simple: Create an
inbound FTP service to read from a remote file

o= Mew External Service _ O]
Select the Service Type or Reqgistry -
Select the bvpe of service o create or registry bo browse, { 3

Filtar: Jbvpe filter text

fvvailable bypes:

= @;‘ Adapters
=-fte FTP
ieftp ddvanced: Create a FTP service using the complete wizard

o

Simple: Create an inbound FTP service to read From a remoke File

Description:

The FTP inbound pakttern creates a service thak retrieves a file in a specific directory on an FTP server, IF ;I
the file is not i an $ML Format, you can specify a daka handler that will kransform From the file conkent

Format to business objects. The file content can be split if the content contains multiple copies of the data
structure For processing.

___a. Click Next
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7. From the next FTP service name screen, for Name, accept the default value ‘FTPExport’ and click

Next
Maodule: IFTPTypicaIInbnundMDdule j Browse, ., | MEW, .
Marmespace: Ihttp:,l',l'FTF‘T*;.-'pi-:aIInI:u:uunu:IMu:u:IuIe,l'FTPExpu:url: v Default
Folder: | Browse. .. |
Marme: | FTPExport

8. From the Business object and location screen, enter these:
___a. Click Browse... next to Business object and a Data Type Selection window is opened
___b. Select Customer under Matching data types and click OK

#= Data Type Selection [_ O

Filter by tvpe, namespace, or file (? = any character, * = any String):
Mew. ..

Matching data tvpes:

| [:l Cuskomer

___c. For FTP server host name, enter <FTP_Machine_Name> (or IP Address of the machine that
has FTP Server), for Ex: wsbetal81.austin.ibm.com

___d. Click Test connection, next to host name and you should get this pop-up window with success
message:

4% Test Results |

11) Conneckion successful

o

___e. Click OK from the Test Results window

__f. For Remote directory, enter full path of the EventDir created on the machine where FTP
server is existing (for Ex: /home/wsbeta/EventDir)

__ 0. For Local staging directory, click Browse... and select <LOCAL_EVENT_DIR>
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Your Business object and location screen should look like this:

#= New Inbound FTP Service M=l
Business object and location

apecify the business object and location For the input File, L_—> .

4

¥hat business object do you want to read from the input file?

Business object:

Custamer {htkpe ) frasa, b, com)xmins/prodfwebspl

Browse, ..

What directory should be polled for the input file?

FTR server host name: | wsbetal49, austin,ibm,com|

Test connection. ..
Remate directary:

[ JrookjDesktop/EventDir I

Where do you want to temporarily put the input file?

Local staging direckary: | C:iLabfiles 70\ FTPInboundiLacalEventDir

___h. Click Next

9. From ‘FTP server security credential’ screen, enter these:

___a. Select the radio button next to Using user name and password
1) User name: username using which you connect to your FTP server (for Ex: root)

2) Password: password for the user to connect to your FTP server

FTP server security credential

Specify the FTP server security credential, l::>

P

How do you want to specify the FTP server security credential?

" Using an existing JAAS alias {recommended)

Jawa Suthentication and Suthorization Services (1665]) alias is the recammended way. for speciiying
security credentials,

12T authentication data entey: |

¥ Using user name and password

The user name and passward will not be encrypted and will be skared as plain kext,

User narne: l rook I
Password: I********I
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___b. Click Next

10. From the Input file format and file content split option screen, enter these:
___a. For input file format, accept the default XML selection

___b. For file content split option, accept the default selection, None

= New Inbound Flat File Service | x|
Input file format and file content split option faf—
Specify the inpuk File Format and the file content splic opkion, 1

(S

What is the input file format?

" Other

Specify a data handler to transform the native data Format to & business object,

[rata handler: | Browse. .. |

Which file content split option do you want to use?

i~ sSplit file content by fixed size

Size (in bykes): |
" split file content by delimiter

Delimiber: |

{” Split file content using a custom splitter

Custan splitter: | Browse. .. |

Split criberias |

£ < Back

___C. Click Next

11. From the ‘Archive directory and wrapper business object’ screen, enter these:

___a. Click Browse... next to Local archive directory and select <LOCAL_ARCHIVE_DIR>
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___b. Check the box next to Use a wrapper business object to contain additional input file
information. This will generate a Customer Wrapper under the Data Types of your Module

o= MNew Inbound FTP Service _ O]
Archive directory and wrapper business object |:> _
Specify the archive directory and option For providing additional input: file information. FE'P '

Where do ¥you want to archive the incoming input file?

Cptionally specify a local archive directary For processed files, The file extension will indicate if the File was
successfully processed,

Local archive directory: | C:iLabfiles 70\ FTPINbound\LocalarchiveDir w

llF Ise a wrapper business object ko contain additional inpuk File infu:urmatiu:unl

___C. Click Finish. The assembly diagram for FTPTypicallnboundModule looks like this:

i .
‘vl TR Tvpicalinboundiodule - Assembly Diagram &2

¢l s Palette
|_ (Eh=] B,

b

L .
| |- Favorites. {?:| ﬁp FTF'Exp-::rli
i

12. Save (Ctrl + S) changes to your assembly diagram

__13. Review the FTPTypicallnboundModule and the generated artifacts: The generated Data Types,
Interface, Data handler (XMLDataHandler) and Data binding (FTPFileXMLDataBinding) under
Configured Resources can be found under FTPTypicallnboundModule. You can open each of these
generated artifacts, business objects and review the properties inside.

El_g FTPTypicallnboundiodule

El:gj Bssembly Diagram
* forreesgont]

..... & Dependencies
..... =] Integration Logic
== Data Types

----- I:I Cuskamer
fo L0 CustamerWrapper
|';_'|---'§' Interfaces

----- & Mapping
EI--FF' Binding Resources

Ell:b commonZonfigurations
[ FTPXMLDataBinding
B2 N UTFERMLDataHandler
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5.2. Add Java component

In this part of the lab, you will add a Java component and then wire the component to the existing Export
interface. The Java component is your endpoint.
1. Open the assembly diagram for FTPTypicallnboundModule (if it is already not open)

___a. From the business integration view, expand FTPTypicallnboundModule and double click
Assembly diagram

2. Drop a Java component to onto the assembly diagram
___a. From the Palette, click Components to expand it

___b. Click Java and then click the empty space of FTPTypicallnboundModule assembly diagram. This
will place a new component, Componentl on the assembly diagram.

3. Wire the FTPExport to the Componentl

a. Select the wire (CL:') icon from the Palette
b. Click FTPExport and then click Componentl to wire them together

c. Select OK for the Add Wire pop-up window:

d. From the top of the Palette, click the Selection Tool icon ( [‘}) to get back to the normal cursor
mode

e. Right-click the empty space of the Assembly diagram and select Arrange Contents
Automatically from the pop-up menu

Your assembly diagram for FTPTypicallnboundModule will look like this:

@ 'ﬁp FTPExport @ I}.ﬂ Componentl
f .- ]

___f. Right-click Componentl and select Generate Implementation from the pop-up menu

___g. On the Generate Implementation panel, select default package, and click OK
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___h. Componentlimpl.java is opened in Assembly editor. Scroll down to the method emit that needs

to be implemented and add this code under that method:

System.out _println(rxxsrxxsrxx ENDPOINT

System.out .printIn(""FILENAME : "+emitlnput.getString("'Filename'™));
DataObject customer = emitlnput.getDataObject(''Content');
String name = customer.getString(‘'CustomerName'™);
System.out .printIn("'NAME----- > "+name);

String address = customer._getString("'Address');
System.out .printIn(""ADDRESS--> "+address);

String city = customer.getString("'City™);

System.out .printIn(C"CITY-——-- > "+city);

String state = customer.getString(‘'State');

System.out .printIn(""'STATE----> "+state);

Note: The code is also available at <FTPFILES>\TypicalCustomerJavaCode.txt for your convenience

__i. Save (Ctrl + S) and close Componentlimpl.java

___j. Save (Ctrl + S) and close Assembly diagram: FTPTypicallnboundModule
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5.3. Test typical pattern scenario

In this part of the lab, you will use the WebSphere Process Server Test Environment to test the SCA
application Inbound processing for the typical pattern with input file having single business object.

1. Add the project to the WebSphere Test Environment server

a. Right-click WebSphere Process Server v7.0 under the Servers view and select Add and
remove projects... from the pop-up menu

b. From the Add and Remove Projects window, select FTPTypicallnboundModuleApp under
Available projects panel and click Add >

c. You will now see the FTPTypicallnboundModuleApp added to the Configured projects

d. Click Finish and wait until the project is being published onto the server. The server is started in
Debug mode if it is not already started before

2. Putthe input files in the event directory

Note: For your convenience, the test files SingleCustomerBO.xml, is placed in <FTPFILES>.

__a. On the machine where the FTP Server is running, put SingleCustomerBO.xml file in the
EventDir. The adapter will poll the copied file from the event directory and will transfer it to the
archive directory

___b. The Customer BO is passed through the emit method and you should see this message in your
Server Logs view (or SystemOut.log):

O = Log message Dec 16, 2008 17:22:43,750 | 00000623 Ak R E W DPOINT emibCustorner ¥kEEdE
D = Log message Dec 16, 2005 17:22:143.750 oao0oezs FILEMAME : SingleCustomerED . xml

O = Log message Dec 16, 2003 17:22:43,750 | 00000623 MAME----- = 1BM

D |= Log message Dec 16, 2008 17:22:43.750 ooo00ezs ADDRESS--3 11501 Burnet Rd

D |= Log message Dec 16, 2008 17:22:43.750 ooo00ezs CITY==-m- = Bskin

1= Log message Dec 16, 2008 17:: 00000623

3. You can also verify the results by reviewing the archive directory

___a. Check the ArchiveDir of your FTP server which should contain the same file name appended
with year, month, date, system time, and processed

___b. Check the <LOCAL_ARCHIVE_DIR> subdirectory which should contain an archive of the event
files, with the same file name appended with year, month, date, system time, and success

4. Restore the Sever Configuration

___a. Right-click WebSphere Process Server v7.0 under the Servers view and select Add and
remove projects... from the pop-up menu

___b. Select FTPTypicallnboundModuleApp under Configured projects and click < Remove

___c. Click Finish after you see the application moved to Available projects. Wait until the application
is being unpublished
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Solution instructions
1. Start WebSphere Integration Developer V7.0 with a new workspace
___a. Follow the instructions outlined in Part 1 of this exercise
2. Import the solution Project Interchange

___a. Import the project interchange file FTPInbound_PI.zip from
<LAB_FILES>\FTPInbound\solution directory

__b. Select File &> Import from the menu
___c. Select Other - Project Interchange in the Import dialog and click Next

o= Import M=] &3

Select
Y
Import a project and its dependent projects from a Zip file, E - 5

Select an import source:

|I:y|:|e filker text

[F-[= Test -
B web
IE? Web services
-2 %ML
E-E= Other
é.....H:p‘ FTP
l% HTTP
|5 Localized Model
E Project Inkerchange

(7) = Back I Mext = I Eirishi Cancel

___d. For the From zip file, click on the Browse button and select the FTPInbound_Pl.zip in the

<LAB_FILES>>\ FTPInbound\solution directory

___e. Enter <LAB_FILES>\FTPInbound\workspace for the Project location root
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___f. Click the Select All button. This will select all modules: CWYFT_FTPFile,
FTPCustominboundModule, FTPDefaultsinboundModule, FTPPSInboundModule, and

FTPTypicallnboundModule
#* Import Project Interchange Contents !EI
Import Projects

Impart Projects from a zip file, |

=4
From zip File: I i\Labfiles7OVFTPINboundsolutiont FTPInbound_PI.zip Browse, .,
Project location rook: I C\LabfilesTOVWFTPINboundiworkspace i Browse. ..

= CWYFT_FTPFile

= FTPCustomInboundiodule
== FTPDefaultsInboundrodule
=+ FTPPSInboundraodule

=5 FTPTvpicalinboundMaodule

Select All § Deselect all | Select Referenced

(7 < Back [exh =

Zancel |

___g. Click Finish
3. Testinbound pass through scenario:

___a. Continue with Part 2.3 and Part 2.4 of this lab to test the inbound pass through scenario with
and without SplitBySize

4. Test inbound non pass through scenario:

___a. Continue with Part 3.3 and Part 3.4 of this lab to test the inbound non pass through scenario
with and without SplitByDelimiter

5. Test inbound scenario with default data binding and data handler: Continue with Part 4.3 of this lab

6. Testinbound scenario using typical pattern: Continue with Part 5.3 of this lab
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What you did in this exercise

In this lab, you started with importing the FTP File Adapter RAR file into your WebSphere Integration
Developer new workspace. Then, you made use of the External Service wizard available in WebSphere
Integration Developer to specify Activation Spec Properties, define data binding, data handler, and function
selector which, after deploying onto the server, will generate business objects and other artifacts.

At the end of each part, you deployed and then tested the adapter application for the scenarios - pass-
through (with and without SplitBySize) test scenario, two content specific or non pass through (with and
without SplitByDelimiter) test scenarios, using all defaults (default data binding, function selector) scenario,

and then finally using the typical pattern.
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Task: Adding remote server to WebSphere Integration Developer test
environment

This task describes how to add a remote server to the WebSphere Integration Developer Test environment.
This example uses a z/OS machine.

1. Define a new remote server to WebSphere Integration Developer.
___a. Right click the background of the Servers view to access the pop-up menu.

___b. Select New - Server.

| &5 Task Flows F'-:. Build Activities (E Properties ﬁz_ Problems ( Server Logs ﬁ% Servers &5 Pﬂ Bsset Repositories\l =8 |

%I 0 o W L

SErVEr

0 at localhos

Cpen F3

___c. Inthe New Server dialog, specify the remote server’s host name, <HOSTNAME>.

___d. Ensure that the appropriate server type, ‘WebSphere Process Server v7.0’ or ‘WebSphere
ESB Server v7.0', is highlighted in the server type list

o= Mew Server _[O0]
Define a New Server -
Choose the bype of server to create

Server's host name: lmvsxxx.rtp.raleigh.ibm.com]

Download additional server adapters
Select the server bype;

Itype filber bext

----- [Fall WebSphere Business Monikor Server v7.0 on WebSphere Application Server ;I
----- ﬁ webSphere Business Monitar Server v7.0 on WebSphere ESE

g ﬁ ‘webSphere Business Monitor Server +7.0 on WebSphere Process Server

WebSphere ESE Server w7.0

‘WebSphere Portal w6.0 Server

-fe.1] WebSphere Portal w6, 1 Server

=
Runs service projects on the WebSphere Process Server ¥7.0,
Server name: | webSphere Process Server w7.0 at myvsood rbp. raleigh.ibm, com
Server runtime environment: IWebSphere Process Server v7.0 j Aadd...

Configure runkime environments...

___e. Click Next
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___f. On the WebSphere Server Settings page, leave the radio button for Manually provide
connection settings selected, and select the box for SOAP

___g. Enter the correct setting (<SOAP_PORT>) for Port column

__h. If security is enabled on your server, select the box for ‘Security is enabled on this server’ and
enter <USERID> for the user ID and <PASSWORD> for the password.

= New Server _ O] x|
WebSphere Application Server Settings - g
Input settings For connecting ko an existing WebSphere Application Serwver,
|

Brofile mame; j Configure profiles. ..

—Setver connection types and administrative porks

| sutomatically. determing connection sebbings

[(: Manually provide connection settings]

Cannection Type | Port | Default port | Description |
I~ IPC 9633 Recommended For local servers

2809 Designed to improve communication wit, .
v _soap a80 J 5550 Designed to be maore firewall compatible

™| rum server with resources within the workspace
V¥ Security is enabled on this server

Current active authentication settings:

User I0: ssadmin

Pagsword: Tt

Application server name: | serverl

___i. Click Finish.

___j- The new server should be seen in the Server view.

| 58 Task Flows F'._:- Build Activities (E Properties n;_ Problemns ( Server Logs (&?&- Servers &5 P@ Bsset Repositories} = O |

B0 =
Server - | Stake | Skakus
\WebSphere Process Server +7.0 at localhost [l Started Synchronized

phere Proc Oatn rtp.raleigh.ibm.com iu: Stopped

2. Start the remote server if it is not already started. WebSphere Integration Developer does not
support starting remote servers from the Server view.

___a. From a command prompt, telnet to the remote system if needed:
‘telnet <HOSTNAME> <TELNET_PORT>’
User ID : <USERID>

Password : <PASSWORD>
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___b. Navigate to the bin directory for the profile being used:
cd <WAS_HOME>/profiles/<PROFILE_NAME>/bin
___¢. Run the command file to start the server: ./startServer.sh <SERVER_NAME>

___d. Wait for status message indicating server has started:

ADMU32001: Server launched. Waiting for initialization status

ADMU30001: Server sssr0l1 open for e-business; process id iIs 0000012000000002
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